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Abstract32

This deliverable is the user manual for the INTO-CPS tool chain, an update33

of deliverable D4.2a [BLL+15]. It is targeted at those wishing to make use34

of the INTO-CPS technology to design and validate cyber-physical systems.35

As a user manual, this deliverable is concerned with those aspects of the tool36

chain relevant to end-users, so it is necessarily high-level. Other deliverables37

discuss finer details of individual components, including theoretical founda-38

tions and software design decisions. Readers interested in this perspective on39

the tool chain should consult deliverables D4.2b [PBLG16], D4.2c [BQ16],40

D4.2d [LNH+16], D5.2a [PLM16], D5.2b [BLM16], D5.2c [BHPG16], D5.2d41

[Gam16], D2.2a [ACM+16], D2.2b [FCC+16], D2.2c [CFTW16] and D2.2d42

[CW16].43
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1 Introduction96

This deliverable is the user manual for the INTO-CPS tool chain. The97

tool chain supports a model-based development and verification approach98

for Cyber-Physical Systems (CPSs). Development of CPSs with the INTO-99

CPS technology proceeds with the development of constituent models us-100

ing established and mature modelling tools. Development also benefits from101

support for Design Space Exploration (DSE). The analysis phase is primarily102

based on co-simulation of heterogeneous models compliant with version 2.0 of103

the Functional-Mockup Interface (FMI) standard for co-simulation [Blo14].104

Other verification features supported by the tool chain include hardware-105

and software-in-the-loop (HiL and SiL) simulation and model-based test-106

ing. Presently there is limited support for Linear Temporal Logic model107

checking of discrete models, with further model checking support being de-108

veloped.109

All INTO-CPS tools can be obtained from110

http://into-cps.github.io111

This is the primary source of information and help for users of the INTO-112

CPS tool chain. The structure of the website follows the natural flow of CPS113

development with INTO-CPS, and serves as a natural aid in getting started114

with the technology. In case access to the individual tools is required, pointers115

to each are also provided.116

Please note: This user manual assumes that the reader has a good under-117

standing of the FMI standard. The reader is therefore strongly encouraged to118

become familiar with Section 2 of deliverable 4.1d [LLW+15] for background,119

concepts and terminology related to FMI.120

The rest of this manual is structured as follows:121

• Section 2 provides an overview of the different features and components122

of the INTO-CPS tool chain.123

• Section 3 explains the relevant parts of the Modelio SysML modelling124

tool.125

• Section 4 explains the different features of the main user interface of126

the INTO-CPS tool chain, called the INTO-CPS Application.127

• Section 5 describes the separate modelling and simulation tools used in128

elaborating and verifying the different constituent models of a multi-129

model.130

7
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• Design Space Exploration (DSE) for INTO-CPS multi-models is pre-131

sented in Section 6.132

• Section 7 describes model-based test automation and model checking133

in the INTO-CPS context.134

• Section 9 provides a short overview of code generation in the INTO-135

CPS context.136

• The appendices are structured as follows:137

– Appendix A lists the acronyms used throughout this deliverable.138

– Appendix B gives background information on the individual tools139

making up the INTO-CPS tool chain.140

– Appendix C describes how the individual tools can be obtained.141

– Appendix D gives background information on the various princi-142

ples underlying the INTO-CPS tool chain.143

2 Overview of the INTO-CPS Tool Chain144

The INTO-CPS tool chain consists of several special-purpose tools from a145

number of different providers. Note that it is an open tool chain so it is146

possible to incorporate other tools that also support the FMI standard for147

co-simulation and we have already tested this with numerous external tools148

(both commercial as well as open-source tools). The constituent tools are149

dedicated to the different phases of co-simulation activities. They are dis-150

cussed individually through the course of this manual. An overview of the151

tool chain is shown in Figure 1. The main interface to an INTO-CPS co-152

simulation activity is the INTO-CPS Application. This is where the user153

can design co-simulations from scratch, assemble them using existing FMUs154

and configure how simulations are executed. The result is a co-simulation155

multi-model.156

The design of a multi-model is carried out visually using the Modelio SysML157

tool, in accordance with the SysML/INTO-CPS profile described in D2.2a158

[ACM+16]. Here one can either design a multi-model from scratch by specify-159

ing the characteristics and connection topology of Functional Mockup Units160

(FMUs) yet to be developed, or import existing FMUs so that the connections161

between them may be laid out visually. The result is a SysML multi-model of162

the entire co-simulation, expressed in the SysML/INTO-CPS profile. In the163

8
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Figure 1: Overview of the structure of the INTO-CPS tool chain.

former case, where no FMUs exist yet, a number of modelDescription164

.xml files are generated from this multi-model which serve as the starting165

point for constituent model construction inside each of the individual simu-166

lation tools, leading to the eventual FMUs.167

Once a multi-model has been designed and populated with concrete FMUs,168

the Co-simulation Orchestration Engine (COE) can be invoked to execute169

the co-simulation. The COE controls all the individual FMUs in order to170

carry out the co-simulation. In the case of tool-wrapper FMUs, the model171

inside each FMU is simulated by its corresponding simulation tool. The tools172

involved are Overture [LBF+10], 20-sim [Con13] and OpenModelica [Lin15].173

RT-Tester is not under the direct control of the COE at co-simulation time, as174

its purpose is to carry out testing and model checking rather than simulation.175

The user can control a co-simulation, for instance by running it with different176

simulation parameter values and observing the effect of the different values177

on the co-simulation outcome.178

Alternatively, the user has the option of exploring optimal simulation pa-179

rameter values by entering a Design Space Exploration phase. In this mode,180
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ranges are defined for various parameters which are explored, in an intel-181

ligent way, by a design space exploration engine that searches for optimal182

parameter values based on defined optimization conditions. This engine in-183

teracts directly with the COE and itself controls the conditions under which184

the co-simulation is executed.185

3 Modelio and SysML for INTO-CPS186

The INTO-CPS tool chain supports a model-based approach to the develop-187

ment and validation of CPS. The Modelio tool and its SysML/INTO-CPS188

profile extension provide the diagramming starting point. This section de-189

scribes the Modelio extension that provides INTO-CPS-specific modelling190

functionality to the SysML modelling approach.191

The INTO-CPS extension module is based on the Modelio SysML extension192

module, and extends it in order to fulfill INTO-CPS modelling requirements193

and needs. Figure 2 shows an example of a simple INTO-CPS Architecture194

Structure Diagram under Modelio. This diagram shows a System, named

Figure 2: Example INTO-CPS multi-model.
195

“System”1, composed of two EComponents of kind Subsystem, named “Sub-196

System”2. These Subsystems have an internal Variable called “variable” of197

type String and expose two FlowPorts named “portIn” and “portOut”. The198

type of data going through these ports is respectively defined by types In199

1An abstract description of an INTO-CPS multi-model.
2Abstract descriptions of INTO-CPS constituent models.
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and Out of kind StrtType. More details on the SysML/INTO-CPS profile200

can be found in deliverable D2.2a [ACM+16].201

Figure 3 illustrates the main graphical interface after Modelio and the INTO-202

CPS extension have been installed. Of all the panes, the following three are

Figure 3: Modelio for INTO-CPS.
203

most useful in the INTO-CPS context.204

1. The Modelio model browser, which lists all the elements of your model205

in tree form.206

2. The diagram editor, which allows you to create INTO-CPS design ar-207

chitectures and connection diagrams.208

3. The INTO-CPS property page, in which values for properties of INTO-209

CPS subsystems are specified.210

3.1 Creating a New Project211

In the INTO-CPSModelling workflow described in Deliverable D3.2a [FGPP16],212

the first step will be to create, as depicted in Figure 4, a Modelio project:213

1. Launch Modelio.214

2. Click on File → Create a project....215

11
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Figure 4: Creating a new Modelio project.

3. Enter the name of the project.216

4. Enter the description of the project.217

5. If it is envisaged that the project will be connected to a Java develop-218

ment workflow in the future (unrelated to INTO-CPS), you can choose219

to include the Java Designer module by selecting Java Project, other-220

wise de-select this option.221

6. Click on Create to create and open the project.222

Once you have successfully created a Modelio project, you have to install223

the Modelio extensions required for INTO-CPS modelling, i.e. both Modelio224

SysML and INTO-CPS extensions, as described at225

http://into-cps.github.io226

If both modules have been correctly installed, you should be able to create,227

under any package, an INTO-CPS Architecture Structure Diagram in order228

to model the first subsystem of your multi-model. For that, in the Mode-229

12
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lio model browser, right click on a Package element then in the INTO-CPS230

entry, choose Architecture Structure Diagram as shown in Figure 5. Fig-231

ure 6 represents an example of an Architecture Structure Diagram. Besides

Figure 5: Creating an Architecture Structure diagram.
232

creating an Architecture Structure Diagram from scratch, the INTO-CPS233

extension allows the user to create it from an existing modelDescription234

.xml file. A modelDescription.xml file is an artifact defined in the235

FMI standard which specifies, in XML format, the public interface of an236

FMU. To import a modelDescription.xml file,237

1. Right click in the Modelio model browser on a Package element, then238

in the INTO-CPS entry choose Import Model description, as shown in239

Figure 7.240

2. Select the desired modelDescription.xml file in your installation241

and click on Import (Figure 8).242

This import command creates an Architecture Structure Diagram describing243

the interface of an INTO-CPS block corresponding to the modelDescrip-244

tion.xml file imported, cf. Figure 9. Once you have created several such245

blocks, either from scratch or by importing modelDescription.xml files,246

you must eventually connect instances of them in an INTO-CPS Connection247

Diagram. To create an INTO-CPS Connection diagram, as for an INTO-248

CPS Architecture Structure Diagram, right click on a Package element, then249

13
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Figure 6: Example Architecture Structure diagram.

in the INTO-CPS entry choose Connection Diagram, as shown in Figure 10.250

Figure 11 shows the result of creating such a diagram. Once you have created251

all desired block instances and their ports by using the dedicated command in252

the Connection Diagram palette, you will be able to model their connections253

by using the connector creation command (Figure 12). At this point your254

blocks have been defined and the connections have been set. The next step255

is to simulate your multi-model using the app. For that you must first gen-256

erate a configuration file from your Connection diagram. Select the desired257

Connection diagram, right click on it and in the INTO-CPS entry choose258

Generate configuration, as shown in Figure 13. In the final step, choose a259

relevant name and click on Generate.260

3.2 Exporting modelDescription.xml Files261

The SysML Connection diagram defines the components of the system and262

their connections. The internals of these block instances are created in263

the various modeling tools and exported as FMUs. The modeling tools264

Overture, 20-sim and OpenModelica support importing the interface def-265

inition (ports) of the blocks in the Connection diagram by importing a266

14
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Figure 7: Importing an existing model description.

Figure 8: Model description selection.

modelDescription.xml file containing the block name and its interface267

definition.268

Follow these steps to export a modelDescription.xml file from Mode-269

lio:270

1. In Modelio, right-click on the model block in the tree.271

2. Select INTO-CPS → Generate Model Description (see Figure 14).272

3. Choose a file name containing the text “modelDescription.xml” and273

click Export (see Figure 15).274

15
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Figure 9: Result of model description import.

Figure 10: Creating a Connection diagram.
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Figure 11: Unpopulated Connection diagram.

Figure 12: Populated Connection diagram.
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Figure 13: Generating a configuration file.

Figure 14: Exporting a modelDescription.xml file.
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Figure 15: Naming the model description file.
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4 The INTO-CPS Application275

This section describes the INTO-CPS Application(here referred to as the276

app), the primary gateway to the INTO-CPS tool chain. Section 4.1 gives277

an introductory overview of the app. Section 4.2 describes how the app278

can be used to create new INTO-CPS co-simulation projects. Section 4.3279

describes how multi-models can be assembled. Section 4.4 describes how co-280

simulations are configured, executed and visualized. Section 4.5 lists some281

additional useful features of the app, while Section 4.6 describes how the282

co-simulation engine itself can be started manually, for specialist use.283

4.1 Introduction284

The app is the front-end of the entire INTO-CPS tool chain. The app defines285

a common INTO-CPS project and it is the easiest way to configure and286

execute co-simulations. Certain features in the tool chain are only accessible287

through the app. Those features will be explained in their own sections288

of the user manual. This section introduces the app and its basic features289

only.290

Releases of the app can be downloaded from:291

https://github.com/into-cps/intocps-ui/releases292

Four variants are available:293

• -darwin-x64.zip – MacOS version294

• -linux-x64.zip – Linux (64 bit) version295

• -win32-ia32.zip – Windows (32 bit) version296

• -win32-x64.zip – Windows (64 bit) version297

The app itself has no dependencies and requires no installation. Simply unzip298

it and run the executable. However, certain app features require Git3 and299

Java 84 to be already installed.300

3https://git-scm.com/
4http://www.oracle.com/technetwork/java/javase/overview/

java8-2100321.html

20
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4.2 Projects301

An INTO-CPS project contains all the artifacts used and produced by the302

tool chain. The project artifacts are grouped into folders. You can create303

as many folders as you want and they will all be displayed in the project304

browser. The default set of folders for a new project, shown in Figure 16, is:305

Figure 16: INTO-CPS project shown in the project browser.
306

Design Space Explorations Scripts and configuration files for performing307

DSE experiments.308

FMUs FMUs for the constituent models of the project.309

Model Checking Configuration files for performing Model Checking exper-310

iments.311

Models Sources for the constituent models of the project.312

Multi-Models The multi-models of the project, using the project FMUs.313

This folder also holds configuration files for performing co-simulations.314

SysML Sources for the SysML model that defines the architecture and con-315

nections of the project multi-model.316

Test-Data-Generation Configuration files for performing test data gener-317

ation experiments.318

In order to create a new project, select File → New Project, as shown in319

Figure 17a. This opens the dialog shown in Figure 17b, where you must320

choose the project name and location – the chosen location will be the root321

21
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(a) New Project menu entry. (b) New Project dialog.

Figure 17: Creating a new INTO-CPS project.

(a) Import Git Project menu entry. (b) Import Git Project dialog.

Figure 18: Importing a Git project.

of the project, so you should manually create a new folder for it. To open an322

existing project, select File → Open Project, then navigate to the project’s323

root folder and open it.324

To import a project stored in the Git version control system, select File →325

Import Project from Git, as shown in Figure 18a. This opens the dialog shown326

in Figure 18b, where you must choose the project location and also provide327

the Git URL. The project is checked out using Git, so any valid Git URL328

will work. You must also have Git available in your PATH environment329

variable in order for this feature to work. It is possible to import several330

public example projects that show off the various features of the INTO-CPS331

tool chain. These examples are described in Deliverable D3.5 [PGP+16]. To332

import an example, select File → Import Example Project, as shown in Figure333

19a. This opens the dialog box shown in Figure 19b, where you must select334

which example to import and a project location. The example is checked out335

via Git, so you must have Git available in your path in order for this feature336

to work. For both Git projects and examples, once you begin the import337

22
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(a) Import Example Project menu. (b) Import Example Project dialog.

Figure 19: Importing examples.

process, a process dialog is displayed, as shown in Figure 20.338

Figure 20: Progress of project imports through Git.

4.3 Multi-Models339

For any given project, the app allows you to create and edit multi-models340

and co-simulation configurations. To create a new multi-model, right click341

the Multi-models node in the project browser and select New multi-model,342

as shown in Figure 21. After creation, the new multi-model is automatically343

opened for editing. To select an existing multi-model for editing, double-344

click it. Once a multi-model is open, the multi-model view, shown in Figure345

22 is displayed. The top box, Overview, displays an overview of the input346

and output variables in the FMUs, as shown in Figure 23. The bottom box,347

Configuration, enables the user to configure the multi-model. In order to348

configure a multi-model, it must first be unlocked for editing by clicking the349

Edit button at the bottom of the Configuration box. There are four main350

areas dedicated to configuring various aspects of a multi-model.351

The FMUs area, shown in Figure 24, allows you to remove or add FMUs352

23
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Figure 21: Creating a new multi-model.

Figure 22: Main multi-model view.

and to associate the FMUs with their files by browsing to, or typing, the353

path of the FMU file. For each FMU file a marker is displayed indicating354

whether the FMU is supported by the app and can be used for co-simulation355

on the current platform. The FMU instances area, shown in Figure 25,356

allows you to create or remove FMU instances and name them. A multi-357

model consists of one or more interconnected instances of various FMUs.358

More than one instance may be created for a given FMU. As a convenient359

workflow shortcut, the Connections area, shown in Figure 26, allows you360

to connect output variables from an FMU instance into input variables of361

another:362

1. Click the desired output FMU instance in the first column. The output363

variables for the selected FMU appear in the second column.364
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Figure 23: Multi-model overview.

Figure 24: FMUs configuration.

2. Click the desired output variable in the second column. The input365

instances appear in the third column.366

3. Click the desired FMU input instance in the third column. The input367

variables for the selected FMU appear in the fourth column.368

4. Check the box for the desired input variable in the fourth column.369

This facility makes it unnecessary to return to Modelio whenever small370

changes must be made to the connection topology of the multi-model. The371

Initial values of parameters area, shown in Figure 27, allows you to set the372

25
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Figure 25: FMU instances configuration.

Figure 26: Connections configuration.

initial values of any parameters defined in the FMUs:373

1. Click the desired FMU instance in the Instance Column.374

2. Select the desired parameter in the Parameters dropdown box and click375

Add.376

3. Type the parameter value in the box that appears.377

Once the multi-model configuration is complete, click the Save button at the378

bottom of the Configuration box.379
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(a) Parameter selection.

(b) Parameter value input.

Figure 27: Initial values of parameters configuration.
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4.4 Co-simulations380

With the INTO-CPS tool chain it is possible to distribute a co-simulation381

across several computing nodes such that FMUs need not be co-located with382

the COE on the same node. This capability caters to situations in which383

FMUs are restricted to simulation on specific platforms for reasons of legacy384

technology, licensing etc. In the current version of the tool chain this func-385

tionality is not fully integrated with the app, and requires the user to start386

the simulation procedure manually. This is discussed in Section 4.6 below.387

The remainder of this section discusses standard co-simulations on a single388

computing node.389

To execute co-simulations of a multi-model, a co-simulation configuration is390

needed. To create a co-simulation configuration, right click the desired multi-391

model and select Create Co-Simulation Configuration, as shown in Figure392

28. After creation, the new configuration automatically opens for editing.393

To select an existing co-simulation configuration, double-click it. Once a

Figure 28: Creating a co-simulation configuration.
394

configuration is open, the co-simulation configuration, shown in Figure 29, is395
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displayed. The top box, Configuration, lets you configure the co-simulation.396

The bottom box, Simulation, lets you execute the co-simulation. In order to

Figure 29: Main co-simulation configuration view.
397

configure a co-simulation, the configuration must first be unlocked for editing398

by clicking the Edit button at the bottom of the Configuration box. There399

are three things to configure for a co-simulation, discussed next.400

The top area, shown in Figure 30, allows you to select the start and end401

time for the co-simulation as well as the master algorithm to be used. For

Figure 30: Start/End time and master algorithm configuration.
402

every algorithm, there are configuration parameters that can be set. These403

are displayed below the top area, as shown in Figure 31. These parameters404

differ with the master algorithm chosen. The Livestream Configuration area,405

shown in Figure 32, allows you to select which variables to live stream and406

plot during the co-simulation. Every instance in the multi-model is displayed407

and the output variables are shown for each instance. Check the box for each408

variable that you wish to live stream. Once the co-simulation configuration is409

complete, click the Save button at the bottom of the Configuration box.410

The Simulation box, shown in Figure 33, allows you to launch a co-simulation.411

To run a co-simulation, the COE must be online. The area at the top of the412
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(a) Fixed step size.

(b) Variable step size.

Figure 31: Master algorithm configuration.

Simulation box displays the status of the COE. If the COE is offline, you413

may click the Launch button to start it. Once a co-simulation is in progress,414

any variables chosen for live streaming are plotted in real time in the simula-415

tion box, as shown in Figure 34. A progress bar is also displayed. When the416

simulation is complete, the live stream plot can be explored or exported as417

a PNG image. In addition, an outputs.csv file is created containing the418

values of every FMU output variable at every point in time in the simula-419

tion. This file can be double-clicked and it will open with the default system420

program for CSV files. It can also be imported into programs such as R,421

MATLAB or Excel for more complex analysis. Furthermore, it is possible422

to add a Post-processing script that receives the csv file name and the total423

simulation time as arguments. It is also possible to configure the amount of424

logging performed by the Co-Simulation Orchestration Engine.425
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Figure 32: Livestream configuration.

(a) COE offline. (b) COE online.

Figure 33: Launching a co-simulation.
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Figure 34: Live stream variable plot.

Figure 35: Co-simulation results file.
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4.5 Additional Features426

The app has several secondary features, most of them accessible through427

the Window menu, as shown in Figure 36. They are briefly explained be-428

low.429

Figure 36: Additional features.

Show Settings displays a settings page where various default paths can430

be set. Development mode can also be enabled from this page, but this431

feature is primarily meant to be used by app developers for testing.432

Show COE Server Status displays a page where you can launch and433

stop the COE as well as observe its log.434

Show Download Manager displays a page where installers can be down-435

loaded for the various tools of the INTO-CPS tool chain, including the436

COE.437

Show FMU Builder displays a page that links to a service where source438

code FMUs can be uploaded and cross-compiled for various platforms.439

Note that this is not a secure service and users are discouraged from440

uploading proprietary FMUs.441

4.6 The Co-Simulation Orchestration Engine442

The heart of the INTO-CPS Application is the Co-Simulation Orchestration443

Engine (COE). This is the engine that orchestrates the various simulation444

tools (described below), carrying out their respective roles in the overall co-445

simulation. It runs as a stand-alone server hosting the co-simulation API on446
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port 8080. It can be started from the app, but it may be started manually at447

the command prompt for testing and specialist purposes by executing:448

java -jar coe.jar 8082449

TCP port 8082 will be chosen by default if it is omitted in the command450

above. The COE is entirely hidden from the end user of the INTO-CPS app,451

but parts of it are transparently configured through the main interface. The452

design of the COE is documented in deliverable D4.1d [LLW+15].453

The COE is controlled using simple HTTP requests. These are documented454

in the API manual, which can be obtained from the COE’s own web page by455

navigating to http://localhost:8082. Port 8082 should be changed to456

that specified when the COE is started.457

Following the protocol detailed in the API document, a co-simulation session458

can be controlled manually from the command prompt using, for example,459

the curl utility, as demonstrated in the following example.460

With the COE running, a session must first be created:461

curl http://localhost:8082/createSession462

This command will return a sessionID that is used in the following com-463

mands.464

Next, assuming a COE configuration file called coeconf.json has been465

created as described in the API manual, the session must be initialized:466

curl -H "Content-Type: application/json"467

--data @coeconf.json468

http://localhost:8082/initialize/sessionID469

Assuming start and end time information has been saved to a file, say470

startend.json, the co-simulation can now be started:471

curl -H "Content-Type: application/json"472

--data @coeconf.json473

http://localhost:8082/simulate/sessionID474

Once the co-simulation run ends, the results can be obtained as follows:475

curl -o results.zip476

http://localhost:8082/result/sessionID/zip477

The session can now be terminated:478

curl http://localhost:8082/destroy/sessionID479

34

http://localhost:8082


D4.3a - INTO-CPS Tool Chain User Manual (Public)

The app fundamentally controls the COE in this way.480

Distributed co-simulations Presently the app can only control the COE481

in this way for non-distributed co-simulations. In order to run a distributed482

co-simulation, the COE must be controlled from the command prompt manu-483

ally, as illustrated above. In a distributed co-simulation the COE and (some)484

FMUs execute on physically different compute nodes. The FMUs local to485

the COE computing node are handled in the same way as in standard co-486

simulations.487

Each FMU on the remote nodes is served externally by a daemon process.488

This process must be started on the remote node manually as follows:489

java -jar daemon.jar -host <public-ip> -ip4490

Here, <public-ip> is the IPv4 address of the compute node.491

Next, the COE process must be started manually from the command prompt492

on its own node, with options specific to distributed co-simulation:493

java -Dcoe.fmu.custom.factory=494

org.intocps.orchestration.coe.distribution.495

DistributedFmuFactory496

-cp coe.jar:daemon-master.jar497

org.intocps.orchestration.coe.CoeMain498

The second difference is the way in which the location of the remote FMUs499

is specified. For a standard co-simulation, the “fmus” clause of the co-500

simulation configuration file (coeconf.json, in our example) contains el-501

ements of the form502

“file://fmu-1-path.fmu”503

These must be modified for each remote FMU to the following URI scheme:504

“uri://<public-ip>/FMU/#file://local-fmu-path.fmu”505

The COE configuration file can, of course, be written manually in its entirety,506

but it is possible to take a faster route, as follows.507

This configuration file is only generated when a co-simulation is executed. It508

is therefore possible to assemble a “dummy” co-simulation that is similar to509

the desired distributed version, but with a local FMU topology. Since it is510

likely that the remote FMUs are not supported on the COE platform itself,511

it is necessary here to construct “dummy” FMUs with the same interface.512
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If this local co-simulation is then executed briefly, a COE configuration file513

will be emitted that can be easily modified as described above. The app514

will name this file config.json and emit it to the Multi-models folder515

under each co-simulation run. This modified configuration can then be used516

to execute the distributed co-simulation.517

5 Using the Separate Modelling and Simula-518

tion Tools519

This section provides a tutorial introduction to the FMI-specific functionality520

of each of the modelling and simulation tools. This functionality is centered521

on the role of FMUs for each tool. For more general descriptions of each tool,522

please refer to Appendix B.523

5.1 Overture524

Overture implements export of both tool-wrapper as well as standalone FMUs.525

It also has the ability to import a modelDescription.xml file in order to526

facilitate creating an FMI-compliant model from scratch. A typical workflow527

in creating a new FMI-compliant VDM-RT model starts with the import528

of a modelDescription.xml file created using Modelio. This results in529

a minimal project that can be exported as an FMU. The desired model is530

then developed in this context. This section discusses the complete work-531

flow.532

5.1.1 Installing the FMI import/export plugin for Overture533

In order to use the FMI integration in Overture it is necessary to install a534

plugin. Below is a guide to install the plugin:535

1. Open Overture.536

2. Select Help -> Install New Software.537

3. Click Add...538

4. In the Name: field write Overture FMU.539

5. In the Location: field there are two options:540
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INTO-CPS Application: Download theOverture FMU Import / Ex-541

porter - Overture FMI Support using the Download Manager men-542

tioned in Section 4.5. Locate the file using the Archive... button543

next to the Location: field.544

Update site: Enter the following URL in the Location: field:545

http://overture.au.dk/into-cps/vdm-tool-wrapper/master/latest.546

6. Check the box next to Overture FMI Integration as shown in Figure547

37.548

7. Click Next or Finish to accept and install.549

Figure 37: Installing Overture FMI Integration

5.1.2 Import of modelDescription.xml File550

A modelDescription.xml file is easily imported into an existing, typ-551

ically blank, VDM-RT project from the project explorer context menu as552

shown in Figure 38. This results in the project being populated with the553

classes necessary for FMU export:554

• A VDM-RT system class named “System” containing the system def-555

inition. The corresponding “System” class for the water tank controller556

FMU is shown in Listing 39.557

• A standard VDM-RT class named “World”. This class is conventional558

and only provides an entry point into the model. The corresponding559

“World” class for the water tank controller FMU is shown in Listing 40.560

• A standard VDM-RT class named “HardwareInterface”. This class con-561

tains the definition of the input and output ports of the FMU. Its struc-562
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Figure 38: Importing a modelDescription.xml file.

ture is enforced, and a self-documenting annotation scheme5 is used563

such that the “HardwareInterface” class may be hand-written. The564

corresponding “HardwareInterface” class for the water tank controller565

FMU is shown in Listing 41.566

• The library file Fmi.vdmrt which defines the hardware interface port567

types used in “HardwareInterface”.568

5The annotation scheme is documented on the INTO-CPS website into-cps.
github.io under “Constituent Model Development → Overture → FMU Import/Export.
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�
system System

instance variables

-- Hardware interface variable required by FMU Import/Export
public static hwi: HardwareInterface := new

HardwareInterface();

instance variables

public levelSensor : LevelSensor;
public valveActuator : ValveActuator;
public static controller : [Controller] := nil;

cpu1 : CPU := new CPU(<FP>, 20);
operations

public System : () ==> System
System () ==
(
levelSensor := new LevelSensor(hwi.level);
valveActuator := new ValveActuator(hwi.valveState);

controller := new Controller(levelSensor, valveActuator);

cpu1.deploy(controller,"Controller");
);

end System
� �
Figure 39: “System” class for water tank controller.
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�
class World

operations

public run : () ==> ()
run() ==
(start(System‘controller);
block();
);

private block : () ==>()
block() ==
skip;

sync

per block => false;

end World
� �
Figure 40: “World” class for water tank controller.

�
class HardwareInterface

values
-- @ interface: type = parameter, name="minlevel";
public minlevel : RealPort = new RealPort(1.0);
-- @ interface: type = parameter, name="maxlevel";
public maxlevel : RealPort = new RealPort(2.0);

instance variables
-- @ interface: type = input, name="level";
public level : RealPort := new RealPort(0.0);

instance variables
-- @ interface: type = output, name="valve";
public valveState : BoolPort := new BoolPort(false);

end HardwareInterface
� �
Figure 41: “HardwareInterface” class for water tank controller.
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The port structure used in the “HardwareInterface” class is a simple inheri-569

tance structure, with a top-level generic “Port”, subclassed by ports for spe-570

cific values: booleans, reals, integers and strings. The hierarchy is shown in571

Listing 42. When a model is developed without the benefit of an existing572

modelDescription.xml file, this library file can be added to the project573

from the project context menu, also under the category “Overture FMU”.574

575

With all the necessary FMU scaffolding in place, the VDM-RT model can be576

developed as usual.577

5.1.3 Tool-Wrapper FMU Export578

Models exported as tool-wrapper FMUs require the Overture tool to sim-579

ulate. Export is implemented such that the VDM interpreter and its FMI580

interface are included in the exported FMU. Overture tool-wrapper FMUs581

currently support Win32, Win64, Linux64, Darwin64 and require Java 1.7582

to be installed and available in the PATH environment variable.583

A tool-wrapper FMU is easily exported from the project context menu as584

shown in Figure 43. The FMU will be placed in the generated folder.585

586
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�
class Port

types
public String = seq of char;
public FmiPortType = bool | real | int | String;

operations

public setValue : FmiPortType ==> ()
setValue(v) == is subclass responsibility;

public getValue : () ==> FmiPortType
getValue() == is subclass responsibility;

end Port

class IntPort is subclass of Port

instance variables
value: int:=0;

operations
public IntPort: int ==> IntPort
IntPort(v)==setValue(v);

public setValue : int ==> ()
setValue(v) ==value :=v;

public getValue : () ==> int
getValue() == return value;

end IntPort

class BoolPort is subclass of Port

instance variables
...
� �

Figure 42: Excerpt of “Fmi.vdmrt” library file defining FMI interface port
hierarchy.
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Figure 43: Exporting a tool-wrapper FMU.
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5.1.4 Standalone FMU Export587

In contrast to tool-wrapper FMUs, models exported as standalone FMUs588

do not require Overture in order to simulate. Instead, they are first passed589

through Overture’s C code generator such that a standalone implementation590

of the model is first obtained. Once compiled, this executable model then591

replaces the combination of VDM interpreter and model, and the FMU ex-592

ecutes natively on the co-simulation platform. Currently Mac OS, Windows593

and Linux are supported, with embedded platform support for SiL and HiL594

simulation under development.595

The export process consists of two steps. First, a source code FMU is ob-596

tained from Overture as shown in Figure 44. Second, the INTO-CPS Appli-597

cation must be used to upload the resulting FMU to the FMU compilation598

server using the built-in facility described in Section 4.5. This is accessed by599

navigating to Window → Show FMU Builder.600

Please note that only some features of VDM-RT are currently supported by601

the C code generator. This is discussed in more detail in Section 9.602

5.2 20-sim603

This section explains the FMI and INTO-CPS related features of 20-sim6.604

We focus on the import of modelDescription.xml files, standalone and605

tool-wrapper FMU export (FMU slave), 3D visualization of FMU operation606

and an experimental FMU import (FMU master) feature. The complete607

20-sim tool documentation can be found in the 20-sim Reference Manual608

[KGD16].609

5.2.1 Import of modelDescription.xml File610

In Modelio it is possible to export the desired interface for a new FMU611

from a multi-model as a modelDescription.xml file (see Section 3.2.612

20-sim can automatically generate an empty 20-sim submodel 7 from this613

modelDescription.xml file with this desired FMU interface. To use614

6Note that 20-sim is Windows-only. However, it can run fine using Wine [Win16] on
other platforms. For details on using 20-sim under Wine, contact Controllab.

7Please note that the term “submodel” here should not be confused with the INTO-CPS
notion of a “constituent model”. A submodel here is a part in a graphical 20-sim model.
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Figure 44: Exporting a standalone FMU.

the modelDescription.xml import, you will need to use the “4.6.2-615

intocps” version of 20-sim8, since this feature is still under development. A616

modelDescription.xml file can be imported into 20-sim by using Win-617

dows Explorer to drag the modelDescription.xml file onto your 20-sim618

model (see Figure 45). This creates a new empty submodel with a blue icon619

that has the same inputs and outputs as defined in the modelDescription620

.xml file.621

5.2.2 Tool-wrapper FMU Export622

A tool-wrapper FMU is a communication FMU that opens the original model623

in the modelling tool and takes care of remotely executing the co-simulation624

8You can download the INTO-CPS version of 20-sim using the Download Manager in
the INTO-CPS Application.
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Figure 45: Import a ModelDescription in 20-sim.

steps inside the modelling using some tool-supported communication mecha-625

nism. 20-sim supports co-simulation using the XML-RPC-based DESTECS626

co-simulation interface [LRVG11]. The generation of a tool-wrapper FMU627

involves two steps that will be explained below:628

1. Extend the model with co-simulation inputs, outputs and shared design629

parameters.630

2. Generate a model-specific tool-wrapper FMU.631

The tool-wrapper approach involves communication between the co-simula-632

tion engine (COE) and the 20-sim model through the tool-wrapper FMU.633

The 20-sim model should be extended with certain variables that can be634

set or read by the COE. These variables are the co-simulation inputs and635

outputs. They can be defined in the model in an equation section called636

externals:637 �
638

externals639

real global export mycosimOutput;640

real global import mycosimInput;641 
� �642

To make it possible to set or read a parameter by the co-simulation engine,643

it should be marked as ’shared’:644 �
645

parameters646

// shared design parameters647

real mycosimParameter (’shared’) = 1.0;648 
� �649

The next step is to generate a tool-wrapper FMU for the prepared model.650
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This requires at least the “4.6.3-intocps” version of 20-sim9. This version of651

20-sim comes with a Python script that generates a tool-wrapper FMU for652

the loaded model.653

To generate the tool-wrapper FMU:654

1. Make sure that the tool-wrapper prepared 20-sim model is saved at655

a writable location. The tool-wrapper FMU will be generated in the656

same folder as the model.657

2. Open the prepared 20-sim model in 20-sim.658

3. Run the BATCH script:659

C:\Program Files (x86)\20-sim 4.6\addons\FMI\660

ToolwrapperFMUExport\generate.bat661

Note that the (x86) is only for 64-bit versions of Windows.662

4. You can find the generated tool-wrapper fmu as <modelname>.fmu in663

the same folder as your model.664

5.2.3 Standalone FMU Export665

Starting with 20-sim version 4.6, the tool has a built-in option to generate666

standalone co-simulation FMUs for both FMI 1.0 and 2.0 (note that version667

2.0 must be used here).668

To export a 20-sim submodel as a standalone FMU, make sure that the part669

of the model that you want to export as an FMU is contained in a submodel670

and simulate your model to confirm that it behaves as desired.671

Next, follow these steps (see also Figure 46):672

1. In the Simulator window, choose from the menu: Tools.673

2. Select Real Time Toolbox.674

3. Click C-Code Generation.675

4. Select the FMU 2.0 export for 20-sim submodel target.676

5. Select the submodel to export as an FMU.677

6. Click OK to generate the FMU. This will pop-up a blue window.678

9You can download the INTO-CPS version of 20-sim using the Download Manager in
the INTO-CPS Application.
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Figure 46: Export an FMU from 20-sim.

Note that to automatically compile the FMU, you will need the Microsoft679

Visual C++ 2010, 2013 or 2015 compiler installed (normally included with680

Microsoft Visual Studio, either Express or Community edition). If 20-sim681

can find one of the supported VC++ compilers, it starts the compilation682

and reports where you can find the newly generated FMU. The 20-sim FMU683

export also generates a Makefile that allows you to compile the FMU on684

Windows using Cygwin, MinGW, MinGW64 or on Linux or MacOS X.685

20-sim can currently export only a subset of the supported modelling lan-686

guage elements as standalone C-code. Full support for all 20-sim features is687

only possible through the tool-wrapper FMU approach (described shortly in688

Section 5.2.2). The original goal for the 20-sim code generator was to export689

control systems into ANSI-C code to run the control system under a real-690

time operating system. As a consequence, 20-sim currently only allows code691

generation for discrete-time submodels or continuous-time submodels using692

a fixed-step integration method. Support for variable step size integration693

methods is not yet included by default in the official 20-sim 4.6 release, but it694

is already included in the 20-sim “4.6.2-intocps” release and on GitHub (see695

below). Other language features that are not supported, (or are only partly696
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supported) for code generation, are:697

• Hybrid models: Models that contain both discrete- and continuous-698

time sections cannot be generated at once. However, it is possible to699

export the continuous and discrete blocks separate.700

• File I/O: The 20-sim “Table2D” block is supported; the “datafromfile”701

block is not yet supported.702

• External code: Calls to external code are not supported. Examples703

are: DLL(), DLLDynamic() and the MATLAB functions.704

• Variable delays: The tdelay() function is not supported due to705

the requirement for dynamic memory allocation.706

• Event functions: timeevent(), frequencyevent() statements707

are ignored in the generated code.708

• Fixed-step integration methods: Euler, Runge-Kutta 2 and Runge-709

Kutta 4 are supported.710

• Implicit models: Models that contain unsolved algebraic loops are711

not supported.712

• Variable-step integration methods: Vode-Adams andModified Back-713

ward Differential Formula (MeBDF) are available on GitHub (see below714

for the link).715

The FMU export feature of 20-sim is being improved continuously based on716

feedback from INTO-CPS members and other customers. To benefit from717

bug fixes and to try the latest FMU export features like variable step size718

integration methods (e.g. Vode-Adams and MeBDF), you can download the719

latest version of the 20-sim FMU export template from:720

https://github.com/controllab/fmi-export-20sim721

Detailed instructions for the installation of the GitHub version of the 20-sim722

FMU export template can be found on this GitHub page. The GitHub FMU723

export template can be installed alongside the existing built-in FMU export724

template.725

5.2.4 3D Animation FMU726

It is possible to visualize a 20-sim simulation as a live 3D animation. This 20-727

sim 3D animation can be exported as a 3D animation FMU that can be used728
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for visualization purposes in a FMI co-simulation experiment. An example729

of a 3D animation FMU in action is shown in Figure 47.730

Figure 47: 3D animation FMU

To create a 3D animation FMU, you will need to create a 3D animation in731

20-sim that reacts to some signals first (identical to the creation of standard732

3D animation in 20-sim):733

1. Open your 20-sim model.734

2. Open the simulator and add a new 3D animation window using View735

→ New 3D animation window.736

3. Create a new 3D animation scene by following the instructions from737

the Animation toolbox section in the 20-sim Getting Started manual738

[KG16].739

4. For elements that should move or change color based on external sig-740

nals, create one equation submodel in 20-sim with all required input741

signals for the animation.742

5. Connect the 3D animation object to the signals from this animation743

submodel.744

The next step is to export the 3D animation as standalone scenery:745

1. Go to the 3D animation plot in your 20-sim model.746
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2. Right-click in the 3D animation plot and select Plot properties.747

3. Choose File → Save scene.748

4. Select Yes to save the whole scenery.749

5. Save the scenery under the name scenery.scn.750

The 3D animation FMU uses the just exported scenery.scn file. Since751

the 3D animation is only a view of the simulation results, the FMU only has752

a list of inputs. To generate a modelDescription.xml file with the right753

FMU interface, a Python script must be executed which collects the list of754

external signals referred to by the exported scenery. This Python script and755

other required resources can be found in the following Controllab GitHub756

repository:757

https://github.com/controllab/fmi-3D-animation758

To generate the FMU modelDescription.xml file, do the following:759

1. Copy the generated scenery.scn in the fmu_sources\resources760

folder under 3D FMU instructions.761

2. Update FMU_GUID in the scenery_to_fmu.py Python script with762

a new GUID for your 3D Animation FMU.763

3. Execute the scenery_to_fmu.py Python script, e.g. using the Python764

installation that comes with 20-sim 4.6:765

• Start IPython found under 20-sim 4.6 in theWindows Start Menu.766

• cd <my 3D FMU instructions path>767

• run scenery_to_fmu.py768

This parses the scenery.scn file for objects that point to vari-769

ables/parameters (references). The variables/parameters are trans-770

lated to FMU inputs and FMU parameters. The 3D scenery does771

not contain any information that indicates whether the referred772

name is a variable or a parameter. As a workaround, all names773

that start with parameter. are marked as as FMU parameters774

(causality = parameter), while all others are generated as inputs775

(variability = continuous). This script also generates a scenery.776

txt file with the list of found references. This file is read by the777

3D animation DLL to couple the FMU interface to the 3D scenery778

objects. The output resembles that shown in Figure 48.779

4. Create the actual FMU:780
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• Copy all needed textures to the fmu_sources\resources folder.781

• Zip the fmu_sources folder.782

• Rename the Zip file, e.g. 3DAnimationFMU.fmu.783

Figure 48: Generating modelDescription.txt file from 3D scenery.

5.2.5 FMI 2.0 Import784

The “4.6.2-intocps” version of 20-sim has an experimental option to import785

an FMU directly in 20-sim for co-simulation within 20-sim itself. This is786

useful for quickly testing exported FMUs without the need to set-up a full787

co-simulation experiment in the app. Presently only FMI 2.0 co-simulation788

FMUs can be imported.789

The procedure for importing an FMU as 20-sim submodel is similar to im-790

porting a modelDescription.xml file. Follow these steps to import an791

FMU in 20-sim:792

1. Copy/move the FMU to the same folder as your model. This is not793

required but recommended to prevent embedding hardcoded paths in794

your model.795

2. Using Windows Explorer, drag the FMU file on your 20-sim model (see796

Figure 49).797
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Figure 49: Importing an FMU in 20-sim.

This creates a new submodel with a blue icon that acts as an FMU wrap-798

per. FMU inputs and outputs are translated into 20-sim submodel input799

and output signals. FMU parameters (scalar variables with causality “pa-800

rameter”) are also available in 20-sim. This means that you can alter the801

default values of these FMU parameters in 20-sim. The altered FMU param-802

eters are transferred to the FMU during the initialization mode phase of the803

FMU.804

5.3 OpenModelica805

This section explains the FMI and INTO-CPS related features of Open-806

Modelica. The focus is on import of modelDescription.xml files, and807

standalone and tool-wrapper FMU export.808

5.3.1 Import of modelDescription.xml File809

OpenModelica can import modelDescription.xml interface files cre-810

ated using Modelio and create Modelica models from them. To use the811

modelDescription.xml import feature, you will need to use OpenMod-812

elica nightly-builds versions, as this extension is rather new. Nightly builds813

can be obtained through the main INTO-CPS GitHub site:814

http://into-cps.github.io815

To import a modelDescription.xml file in OpenModelica one can use:816
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1. The OpenModelica Connection Editor GUI (OMEdit): FMI → Import817

FMI Model Description.818

2. A MOS script, i.e. script.mos, see below.819 �
820

// start script.mos821

// import the FMU modelDescription.xml822

importFMUModeldescription("path/to/modelDescription.xml");823

getErrorString();824

// end script.mos825 
� �826

The MOS script can be executed from command line via:827 �
828

// on Linux and Mac OS829

> path/to/omc script.mos830

// on Windows831

> %OPENMODELICAHOME%\bin\omc script.mos832 
� �833

The result is a generated file with a Modelica model containing the inputs834

and outputs specified in modelDescription.xml. For instance:835 �
836

model Modelica_Blocks_Math_Gain_cs_FMU "Output the product837

of a gain value with the input signal"838

Modelica.Blocks.Interfaces.RealInput u "Input signal839

connector" annotation(Placement(transformation(extent840

={{-120,60},{-100,80}})));841

Modelica.Blocks.Interfaces.RealOutput y "Output signal842

connector" annotation(Placement(transformation(extent843

={{100,60},{120,80}})));844

end Modelica_Blocks_Math_Gain_cs_FMU;"845 
� �846

This functionality will ultimately be integrated in the OMEdit (the Open-847

Modelica Connection Editor) graphical user interface.848

5.3.2 FMU Export849

Currently all FMUs exported from OpenModelica are standalone. There are850

two ways to export an FMU:851

1. From a command prompt.852

2. From OMEdit (OpenModelica Connection Editor).853
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FMU export from a command prompt To export an FMU for co-854

simulation from a Modelica model a Modelica script file generateFMU.mos855

containing the following calls to the OMC compiler can be used:856 �
857

// load Modelica library858

loadModel(Modelica); getErrorString();859

860

// load other libraries if needed861

// loadModel(OtherLibrary); getErrorString();862

863

// generate the FMU: PathTo.MyModel.fmu864

translateModelFMU(PathTo.MyModel, "2.0", "cs");865

getErrorString();866 
� �867

Next, the OMC compiler must be invoked on the generateFMU.mos script:868 �
869

// on Linux and Mac OS870

> path/to/omc generateFMU.mos871

// on Windows872

> %OPENMODELICAHOME%\bin\omc generateFMU.mos873 
� �874

FMU export from OMEdit One can also use OMEdit (the OpenMod-875

elica Connection Editor) to export an FMU as detailed in the figures be-876

low.877

• Open OMEdit (see Figure 50).878

• Load the model in OMEdit (see Figure 51).879

• Open the model in OMEdit (see Figure 52).880

• Use the menu to export the FMU (see Figure 53).881

• The FMU is now generated (see Figure 54).882

The generated FMU will be saved to %TEMP%\OpenModelica\OMEdit.883

884
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Figure 50: Opening OMEdit.

Figure 51: Loading the Modelica model in OMEdit.
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Figure 52: Opening the Modelica model in OMEdit.

Figure 53: Exporting the FMU.
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Figure 54: Final step of FMU export.
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6 Design Space Exploration for INTO-CPS885

This section provides a description of tool support for design space explo-886

ration (DSE) developed as part of the INTO-CPS project. Presently the887

INTO-CPS Application does not provide support for automated creation of888

the configuration files required to define a DSE experiment. Therefore, this889

section is split into three parts. Section 6.1 describes how the INTO-CPS890

Application can be used to launch a DSE using an existing configuration891

file and Section 6.2 describes how the results from DSE are generated and892

stored. Section 6.3 describes the structure of the DSE configuration file, giv-893

ing enough detail for the user to be able to edit one for their purposes.894

6.1 How to Launch a DSE895

To launch a DSE we need to provide the INTO-CPS Application with the896

path to two files. The first is the DSE configuration, defining the parameters897

of the design space, how it should be searched, measured and the results com-898

pared. The second is the multi-model configuration, defining the base model899

that will be used for the search. A DSE configuration is selected by double900

clicking on one of the configurations listed in the Design Space Explorations901

section of the INTO-CPS Application project explorer; these configurations902

are identified with the ( ) icon. If the COE is not already running, the903

DSE page is shown with a red “Co-simulation engine not running” status,904

as shown in Figure 55.905

If this is the case, click on the Launch button to start the COE. This re-906

sults in a green co-simulation engine status (see Figure 56). With the DSE907

configuration selected and the COE running, the next step is to select the908

multi-model to use. One can be selected from the Co-simulation Configura-909

tion drop-down box, as shown in Figure 57. Pressing the Simulate button910

starts the DSE background process.911
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Figure 55: Status when COE is not running.

Figure 56: Status when COE is running.

Figure 57: Selecting a multi-model.
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6.2 Results of a DSE912

The DSE scripts store their results in a folder named for the date and time913

at which the DSE was started. This folder may be found underneath the914

name of the DSE script selected, as shown in Figure 58. When the DSE has915

finished, we can find both a graphs folder and an HTML results page inside916

the results folder. It may be necessary to refresh the project view to see these917

new items. The results HTML file is identified by the ( ) icon, and double918

clicking on it opens the results page in the default browser.

Figure 58: Icon shown when DSE results are ready.
919

The results, shown in Figure 59, contain two elements. The first element is920

a Pareto graph showing the results of all simulations on a single plot, with921

each point on the graph representing a single simulation. The best designs,922

referred to as the non-dominated set, are shown in blue, with ranks of progres-923

sively worse designs coloured alternately red and yellow. The second element924

is a table of these results, with the rank in the left hand column, followed925

by the objective values and finally the design parameters that produced the926

result.927

6.3 How to Edit a DSE Configuration928

Editing of a DSE configuration is currently a manual process and so guidance929

regarding each section of the configuration is presented in this section.930
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Figure 59: A page of DSE results.

6.3.1 File Creation931

The suggested procedure for creating a new configuration is to make a copy932

of an existing one and then to edit the required sections. The individual933

configurations are located in their own folders within the Design Space934

Exploration folder of the INTO-CPS Application project directory, such935

as the pilot study with the line following robot “LFR-2SensorPositions” con-936

figuration shown in Figure 60 (see [PGP+16]). Using your OS’s file browser,937

create a new folder under DSEs and then copy in and rename a DSE configu-938

ration. The names of the new folder and configuration folder can be chosen at939

will, but the configuration file must have the extension .dse.json .940
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Figure 60: Location of DSE configurations.

6.3.2 Parameters941

The parameters section is used to define a list of values for each parameter942

to be explored. Figure 61 shows the definition of four parameters, each with943

two values. If a parameter is included in the DSE configuration file, then it944

must have at least one value defined. The order of the values in the list is945

not important. If a parameter that is to be explored is not in the list, its ID946

may be found in the three ways listed below.947

1. If the parameter is listed in the multi-model configuration, then copy948

it from there.949

2. If the parameter is not in the multi-model parameters list then its name950

may be found by examining the model description file in the associated951

FMU. In this case it will be necessary to prepend the parameter ID952

with the ID for the FMU and the instance ID of the FMU, for example953

in “{sensor1FMU}.sensor1.lf_position_x”.954

• the ID of the FMU is {sensor1FMU}.955

• the instance ID of the FMU in the multi-model is sensor1.956

• the parameter ID is lf_position_x.957

3. The IDs for each parameter may also be found on the Architecture958

Structure Diagram in the SysML models of the system. The full name959

for use in the multi-model may then be constructed as above.960
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Figure 61: Example parameter definitions.

6.3.3 Parameter Constraints961

It may be the case that not all combinations of the parameter values defined962

in the previous section are valid. So, it is necessary to be able to define963

constraints over the design parameters such that no time is wasted simulating964

invalid designs. For example, in the line follower robot we define ranges for965

the x and y co-ordinates of the left and right sensors separately, and running966

all combinations of these leads to asymmetric designs that do not have the967

same turning behaviour on left and right turns. To prevent this we can define968

boolean expressions based upon the design parameters and evaluate these969

before a simulation is launched. Figure 62 shows two constraints defined for970

the line follower DSE experiment that ensure only symmetrical designs are971

allowed. The first constraint ensures the y co-ordinates of both sensors are972

the same, while the second constraint ensures that the x co-ordinate of the973

left sensor is the same, but negated as the x co-ordinate of the right sensor.974

Note that the names used when defining such constraints have the same975

FMU_ID.instance_ID.parameter_ID format as used when defining a976

parameter range (see Section 6.3.2)977

Since the constraints are processed using the Python eval function, any978

boolean expression compatible with it may be used here.

Figure 62: Example parameter constraints.
979
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6.3.4 Scenario List980

The DSE scripts currently have limited support for scenarios referring to a981

specific set of conditions against which the multi-model is to be tested. In982

the example of the line following robot, the scenario refers to the map the983

robot has to follow, along with its starting co-ordinates. For instance, in984

one scenario the robot would go around a circular track in one direction,985

predominantly turning left, whereas in a different scenario the same track986

would be followed in the opposite direction, predominantly turning right. In987

both scenarios the map of the track is the same.988

Changing a scenario may involve changing one or more different parts of989

the multi-model and its analysis, such as the specific FMUs used, parame-990

ters passed to an FMU, the multi-model the DSE is based upon, along with991

any data files used by the objective scripts (Section 6.3.6) to evaluate perfor-992

mance. This feature is currently under development and so only the objective993

data file selection is implemented presently.994

6.3.5 Objective Definitions: Internal995

There are two means for defining the objectives used to assess the perfor-996

mance of a simulated model. The first of these, described here, is using the997

internal functions included in the DSE scripts. This is a set of simple func-998

tions that can be applied to any of the values recorded by the COE during999

simulation. The current set of internal functions is:1000

max Returns the maximum value of a variable during a simulation.1001

min Returns the minimum value of a variable during a simulation.1002

mean Returns the mean value of a variable during a simulation (n.b., a fixed1003

simulation step size is currently assumed.)1004

Defining an internal objective requires three pieces of information:1005

name This is the name that the objective value will be stored under in the1006

objectives file.1007

type This selects the function to be applied. The key objectiveType is1008

used in the DSE configuration file.1009

variable This defines the variable to which the function is to be applied.1010

The key columnID is used to denote this parameter in the DSE con-1011

figuration file.1012
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Figure 63: Definition of an internal objective.

Figure 63 shows the definition of an objective named energyConsumed,1013

which records the maximum value of the variable1014

{bodyFMU}.body.total_energy_used. This objective is recorded and1015

may be used later, primarily for the purpose of ranking designs, but it could1016

also be used for any other analysis required.1017

6.3.6 Objective Definitions: External Scripts1018

The second form of objective definition makes use of user-defined Python1019

scripts to allow bespoke analysis of simulation results to be launched auto-1020

matically and results recorded using the common format. The definition has1021

two parts: the construction of the Python script to perform the analysis and1022

the definition of the script’s required parameters in the DSE configuration1023

file, these two steps are described below.1024

Construction of the Script The outline functionality of an analysis script1025

is that, at the appropriate times, a DSE script calls it, passing four or more1026

arguments. The script uses these arguments to locate a raw simulation results1027

file (results.csv), processes those results and then writes the objective1028

values into an objectives file (objectives.json) for that simulation.1029

The first three arguments sent to the script are common to all scripts. These1030

are listed below.1031

argv 1 The absolute path to the folder containing the results.csv re-1032

sults file. This is also the path where the script finds the1033

objectives.json file.1034

argv 2 The name of the objective. This is the key against which the script1035

should save its results in the objectives file.1036

argv 3 The name of the scenario.1037

With this information the script can find the raw simulation data and also1038

determine where to save its results. The name of the scenario allows the script1039
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to locate any data files it needs relating to the scenario. For example, in the1040

case of the script measuring cross track error for the line following robot,1041

the script makes use of a data file that contains a series of coordinates that1042

represent the line to be followed. The name of this data file is map1px.csv.1043

It is placed into a folder with the same name as the scenario, which in this1044

case is studentMap. That folder is located in the userMetricScripts1045

folder, as shown in Figure 64. Using this method, the developer of an external1046

analysis script needs only to define the name of the data file they will need and1047

know that at runtime the script will be passed a path to a folder containing1048

the data file suitable for the scenario under test.

Figure 64: External analysis script data files for the “studentMap” scenario.
1049

Figure 65 shows an example of an external analysis script. In this case it1050

computes the cumulative deviation of the water level from some target level.1051

There are two distinct sections in the file, we shall refer to them as the1052

’common’ and ’script specific’ sections.1053

The common section contains core functions that are common to all ex-1054

ternal scripts. It reads in the three arguments that are common to all1055

scripts, and contains functions to help the user retrieve the data needed1056

by the analysis script, and to write the computed objective value into the1057

objectives.json file. It is recommended that this section be copied to1058

form the basis of any new external analysis scripts.1059

The second part of the example script shown is specific to the analysis to1060

be performed. The purpose of this section is to actually compute the value1061

of the objective from the results of a simulation. Generally it will have1062

three parts: reading in any analysis specific arguments such as the ID of1063

data in the results that it needs, using the data in results.csv to cal-1064
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Figure 65: External analysis script to calculate cumulative deviation in the
water tank example
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culate the value of the objective and finally write the objective value into1065

objectives.json.1066

In the ’Script Specific Section’ of Figure 65 we see the example of the script1067

calculating the cumulative deviation of the water level from a target level in1068

the water tank model. It starts by reading a further two arguments passed1069

when the script is launched and initializes the variables. The script then it-1070

erates through all rows of data in results.csv to calculate the cumulative1071

deviation which is then written to the objectives.json file in the final1072

line.1073

Figure 66: Definition of the external analysis functions for the line follower
robot.

Definition of External Analysis in DSE Configuration With the1074

analysis scripts constructed, the next step is to define their use in the DSE1075

configuration file. The definition essentially contains three parts:, a name for1076

the objective, the file name of the script and a list arguments to pass. The1077

name given to the objective allows it to be referenced in the objectives con-1078

straints and ranking sections of the DSE configuration. The file name tells1079

the DSE scripts which script to launch and the arguments define additional1080

data (over the standard three arguments described earlier) that the script1081

needs, such as the names of data it needs or constant values.1082

In Figure 67 we find the definition of the external analysis used in the three1083

tank water tank example. There are two analysis defined, the first is named1084

’cumulativeDeviation’ and the second is ’vCount’. In each there are two1085

parameters defined, the ’scriptFile’ contains the file name of the script file to1086

run in each case, while the ’scriptParameters’ parameter contains the list of1087
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additional arguments each needs.1088

Figure 67: Definition of the external analysis functions for the three water
tank model.

The purpose of both internal and external analysis functions is to populate1089

the objectives.json file with values that characterize the performance1090

of the designs being explored. Figure 68 shows an example objectives file1091

generated during a DSE of the three water tank example. There is an instance1092

of the objectives file created for each simulation in DSE, its primary use being1093

to inform the ranking of designs, but it may be used for any other analysis a1094

user wishes to define.

Figure 68: Contents of objectives.json file for a single simulation of
the three tank water tank

1095

6.3.7 Ranking1096

The final part of a DSE configuration file concerns the placing of designs in a1097

partial order according to their performance. The DSE currently supports a1098

Pareto method of ranking, as was shown earlier in Figure 59. The purpose of1099

the ranking section of the configuration is to define the pair of objectives that1100

will be used to rank the designs, and whether to maximize or minimize each.1101

Figure 69 shows an example of a ranking definition from the line following1102

robot example. Here the user has specified that the lap time and mean1103
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cross track error objectives will be used to rank. The use of ’-’ after each1104

indicates that the aim is to minimize both, whereas a ’+’ indicates the desire1105

to maximize.

Figure 69: Defining parameters and their preferred directions for ranking.
1106

Combining all these sections results in a complete DSE configuration, as1107

shown in Figure 70.1108
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Figure 70: A complete DSE configuration for the line follower robot example.
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7 Test Automation and Model Checking1109

Test Automation and Model Checking for INTO-CPS is provided by the RT-1110

Tester RTT-MBT tool. This section first describes installation and configu-1111

ration of RT-Tester MBT in Section 7.1. It then describes test automation1112

in Section 7.2 and model checking in Section 7.3. Note, that these features1113

are explained in more detail in the deliverables D5.2a [PLM16] and D5.2b1114

[BLM16], respectively.1115

7.1 Installation of RT-Tester RTT-MBT1116

In order to use RTT-MBT, a number of software packages must be installed.1117

These software packages have been bundled into two installers:1118

• VSI tools dependencies bundle:1119

This bundle is required on the Windows platform and installs the fol-1120

lowing third party software:1121

– Python 2.7.1122

– GCC 4.9 compiler suite, used to compile FMUs.1123

• VSI tools – VSI Test Tool Chain:1124

– RT-Tester 6.0, a stripped version of the RT-Tester core test system1125

that contains the necessary functionality for INTO-CPS.1126

– RT-Tester MBT 9.0, the model-based testing extension of RT-1127

Tester.1128

– RTTUI 3.9, the RT-Tester graphical user interface.1129

– Utility scripts to run RTT-MBT.1130

– Examples for trying out RTT-MBT.1131

These bundles can be downloaded via the download manager of the INTO-1132

CPS Application.1133

7.1.1 Setup of the RT-Tester User Interface1134

When the RT-Tester User Interface (RTTUI) is first started, a few configu-1135

ration settings must be made.1136
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• User name and company name (Figure 71a).1137

• Location of Bash shell (Figure 71b): You can safely skip this step by1138

clicking Next.1139

• Path to Python 2.7 executable (Figure 71c): Click Detect and then1140

Installation Path for auto-detection, or Browse to select manually.1141

• Location of RT-Tester (Figure 71d): Click Browse to select the direc-1142

tory of your RT-Tester installation. Note that if you did not specify1143

the Bash shell location in step 7.1.1, the version number might not be1144

properly detected.1145

(a) Configuring user. (b) Configuring Bash.

(c) Configuring Python. (d) Configuring RT-Tester.

Figure 71: RT-Tester GUI configuration.

7.2 Test Automation1146

Configuring and using a Test Project involves several activities. These are:1147

• Creating a test project.1148

• Defining tests.1149
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• Compiling test driver FMUs.1150

• Setting up test runs.1151

• Running tests.1152

• Evaluating test results.1153

These activities can be performed either solely using the RT-Tester graphical1154

user interface, or using a combination of the INTO-CPS Application and the1155

RT-Tester GUI. In this section we focus on describing the latter, since it1156

supports the complete set of features necessary for test automation. The1157

INTO-CPS Application currently only exposes a subset of these. A more1158

comprehensive description of the test automation workflow can be found in1159

deliverable D5.2a [PLM16].1160

In the INTO-CPS Application test automation functionality can be found1161

below the main activity Test-Data-Generation in the project browser. Before1162

using most of the test automation utilities, the license management process1163

has to be started. To this, end right-click on Test-Data-Generation and select1164

Start RT-Tester License Dongle (see Figure 72).

Figure 72: Starting the license management process.
1165

After developing the behavioural model in Modelio and exporting it to an1166

XMI file, test automation projects can be created from the INTO-CPS Ap-1167

plication. Such a project is then added as a sub-project within a containing1168

INTO-CPS Application project. To create a project, do the following:1169
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1. Right-click on Test-Data-Generation in the project browser and select1170

Create Test Data Generation Project (see Figure 73).1171

2. Specify a name for the project, select the XMI file containing the test1172

model and press Create, as shown in Figure 74.1173

Figure 73: Creating a test automation project.

The newly created sub-project and its directory hierarchy is displayed in the1174

project browser. Some directories and files of the RT-Tester project that1175

are not of great importance to the INTO-CPS workflow are hidden from the1176

browser. The following two folders are of special significance:1177

• TestProcedures contains symbolic test procedures where test objec-1178

tives are specified in an abstract way, for example by specifying Linear1179

Temporal Logic (LTL) formulas.1180

• From these symbolic test procedures, concrete executable (RT-Tester 6)1181

test procedures are generated, which then reside in the folder RTT_1182

TestProcedures.1183

The specification of test objectives is done using the RT-Tester GUI. The1184

relevant files can be opened in the RT-Tester GUI directly from the INTO-1185

CPS Application by double-clicking them:1186

• conf/generation.mbtconf allows you to specify the overall test1187

objectives of the test procedure. Test objectives can be specified as1188

LTL formulas, which must then be fulfilled during a test run. Test1189
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Figure 74: Test automation project specifics.

goals can also be specified by selecting structural elements from a tree1190

representation of the test model and then choosing a coverage metric1191

for that element. For example, the user might select a sub-component1192

of the System Under Test (SUT) and specify that all Basic Control1193

States (BCS) must be reached (see Figure 75), or that all transitions1194

must be exercised (TR) in a test run.1195

• conf/signalmap.csv allows you to configure the input and output1196

signals of the system under test (see Figure 76). This includes defining1197

the admissible signal latencies for checking the SUT’s outputs in a test1198

run. This file also allows you to restrict the range of the signals in order1199

to constrain these values during test data generation.1200

More details on the definition of tests can be found in deliverable D5.2a1201

[PLM16].1202

After defining the test objectives, a concrete test case can be created by right-1203

clicking on the symbolic test case under TestProcedures and then selecting1204

Solve (see Figure 77).1205
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Figure 75: Configuring a test goal.

Figure 76: Configuring signals.
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Figure 77: Generating a concrete test procedure.
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A solver component then computes the necessary timed inputs to realize the1206

test objectives. A concrete test procedure is generated that feeds a system1207

under test with these inputs and observes its outputs against expected results1208

derived from the test model. This test procedure will be placed in RTT_1209

TestProcedures and has the same name as the symbolic test procedure.1210

Figure 78 shows how test generation progresses.

Figure 78: Test data generation progress.
1211

A generated test procedure can be cast into an FMU, which can then be1212

run in a co-simulation against the system under test. To this end, right1213

click on the concrete test procedure and select Generate Test FMU (see1214

Figure 79). In cases where a real and perhaps physical system under test is1215

not available, a simulation of the system under test can be generated from1216

the behavioural model. To generate such an FMU, right-click on Simulation1217

an select Generate Simulation FMU as depicted in Figure 80.1218

In order to run a test, right-click on the test procedure and select Run Test1219
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Figure 79: Generating a test FMU.

Figure 80: Generating a simulation FMU.

(see Figure 81). Then specify the FMU of the system under test. If the sys-1220

tem under test is to be replaced by a simulation, press on the corresponding1221

Simulation button. The duration of the test is derived during test data gen-1222

eration and does not need to be manually specified. However, an appropriate1223

step size must be set. Finally, after making sure the COE is running, press1224

Run to start the test (see Figure 82).1225

Every test execution yields as its result an evaluation of test cases, i.e., each is1226

associated with a verdict of PASS, FAIL, or INCONCLUSIVE.10 The details1227

are found in the test log files below the folder testdata. See the RT-Tester1228

10The verdict can also be NOT TESTED. This means a test case has been included in
a test procedure, but a run that reaches it is still missing.
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Figure 81: Running a test.

user manual [Ver15a] for details.1229

The file testcase_tags.txt gives a condensed record of test case, ver-1230

dict, and point in a *.log file where a corresponding PASS, FAIL, or—1231

in case of INCONCLUSIVE—test case occurrence without assertion can1232

be found. The project-wide test-case verdict summary as well the require-1233

ment verdict summary can be found in the folder RTT_TestProcedures/1234

verification. More details on the evaluation of test runs can be found1235

in deliverable D5.2a [PLM16].1236

7.3 Model Checking1237

This section describes how to use the INTO-CPS Application as a front-1238

end to the LTL model checker of RT-Tester RTT-MBT. More details on the1239

algorithms used and the syntax of LTL formulas can be found in deliverable1240

D5.2b [BLM16].1241

Once an INTO-CPS project has been created (see Section 4.2), model check-1242

ing functionality can be found under the top-level activity Model Checking in1243

the project browser. Before getting started, the RT-Tester license manage-1244

ment process must be launched. To this end, right-click on Model Checking1245

and select Start RT-Tester License Dongle (see Figure 83). Model checking1246

projects are presented as sub-projects of INTO-CPS Application projects. In1247

order to add a new project,1248

1. Right-click on the top-level activity Model Checking in the project1249

browser and select Create Model Checking Project (see Figure 84).1250
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Figure 82: Configuring a test.

2. Provide a project name and the model that has been exported to XMI1251

from Modelio.1252
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Figure 83: Starting the RT-Tester license dongle.

Figure 84: Creating a model checking project.
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Figure 85: Specifying the model checking project.
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After pressing Create, a new node representing the model checking project is1253

added to the project browser.1254

The next step is to add LTL queries to the project:1255

1. Right click on the project and select Add LTL Query (see Figure 86).1256

2. Enter a name for the new query (see Figure 87).1257

3. To edit the LTL query, double click on the corresponding node in the1258

project browser (see Figure 88). The LTL formula can then be edited in1259

a text field. Note that the editor supports auto-completion for variable1260

names and LTL operators (see Figure 89).1261

4. Provide the upper bound for the bounded model checking query.1262

Figure 86: Adding an LTL formula.

Figure 87: Naming the new LTL formula.
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Figure 88: Opening the LTL formula editor.

To check the query, press Save & Check. A window opens and is filled with1263

the output of the model checking tool. The tool either reports that the query1264

holds within the specified number of steps — as depicted in Figure 90 — or1265

it prints a counterexample to demonstrate that the property does not hold.1266

1267

It is possible to configure abstractions11 for a particular model checking1268

project. To do so, double-click on the corresponding Abstractions node below1269

that project in the project browser. It is then possible to choose an abstrac-1270

tion method for each output variable of an environment component along1271

with making the associated setting. In Figure 91 the interval abstraction has1272

been selected for the output variable voltage. This abstraction has further1273

been configured to restrict the variable’s value within the interval [10, 12].1274

After pressing Save, this abstraction is applied to all model checking queries1275

in the current model checking project.1276

11Information on abstractions and their associated configuration items can be found in
deliverable D5.2b [BLM16].
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Figure 89: LTL formula editor.

Figure 90: Model checking result.
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Figure 91: Configuring abstractions.

89



D4.3a - INTO-CPS Tool Chain User Manual (Public)

8 Traceability support for INTO-CPS1277

This section provides a description of tool support for traceability developed1278

as part of the INTO-CPS project.1279

8.1 Overview1280

Traceability support is divided into two steps: sending data from the tools1281

to the traceability database, and retrieving information from the database.1282

Currently, only the first part is available in prototypes in the different tools.1283

This is documented below.1284

8.2 INTO-CPS application1285

The traceablility daemon is now (since INTO-CPS App 2.1.19 RC) inte-1286

grated in the App and it starts with the App. Only Neo4J has to be down-1287

loaded. To do so, one can use the download-manager of the INTO-CPS App.1288

When downloaded, Neo4J needs to be extracted by hand into the folder1289

<user>/into-cps-projects/install (the archive file is located at1290

<user>/into-cps-projects/install_downloads after download).1291

Note that Neo4J is a singleton, so make sure all other instances of Neo4J are1292

down before starting the App.1293

Treaceability information is captured by the traceability daemon and stored1294

in a Neo4J database. The database is project specific and is deployed1295

on project change within the App. When running, Neo4J is accessible at1296

http://localhost:7474. Here one can view the current traceability1297

graph.1298

Username and password of the databases are always:1299

username = intoCPSApp1300

password = KLHJiK8k2378HKsg823jKKLJ89sjklJHBNf8j8JH7FxE1301

1302

To view the raw data from the database, right-click on the “traceability” entry1303

in the project browser (in the App) and select “view traceability graph” (see1304

figure 92). Select the database symbol, and click in “relationship types” on1305

“Trace”. This shows you the graph database. By default, the view is limited1306
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to 25 entries. To change this, edit the line MATCH p=()-[r:Trace]->()1307

RETURN p LIMIT 25 and set the limit to a different value.1308

Figure 92: Current view of the traceability in the app

8.3 Modelio1309

The Modelio module can be downloaded here: https://www.dropbox.1310

com/s/bad36t9f8x4n0gl/INTOCPS_1.1.03.jmdac?dl=0. Modelio1311

supports traceability for the following modelling activities:1312

• Model creation1313

• Model modification1314

Steps:1315

Go to Configuration > Modules... Select INTO-CPS and set the parameters.1316

To commit a change, right click on any element and use the INTO-CPS >1317

Commit command.1318

8.4 20-sim1319

Use any version of 20-sim 4.6.3-intocps or higher. The one in the download1320

manager for version 2.1.19 RC is not sufficient. The first suitable release1321

bundle is 0.0.12.1322
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Figure 93: Configuration of traceability features in Modelio

Figure 94: Commit the traceability information in Modelio
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The download can be found here:1323

https://dl.dropboxusercontent.com/u/7249985/1324

controllab/20sim/20-sim-4.6.3.7590-intocps-win32.1325

exe.1326

During installation, make sure you keep the Python option enabled. This is1327

necessity, even if you already have another Python installation on your PC.1328

This Python version will only overwrite Python versions you installed earlier1329

with 20-sim, it will not install other Python versions.1330

Currently, the actions “create model” and “modify model” are supported by1331

20-sim1332

In 20-sim, go to Tools > Version Control Toolbox > Traceability. First enable1333

“GIT version control” and insert a GIT repository, which can be an existing1334

GIT repository or a folder in the local file system. The model will be com-1335

mitted to this repository on a “save” (modify) or “save as” (create) action. If1336

the model does not reside in the GIT repository, it will also be copied to the1337

GIT repository on a “save” or “save as” action.1338

You can leave the “Write custom save messages” option unchecked, as it is1339

not currently fully functional.1340

If you would like to send data to the traceability daemon as well, then you1341

can enable “INTO-CPS Traceability Daemon”. Below, you can then enter the1342

IP-address and Port of the daemon. If you run the INTO-CPS application1343

and traceability deamon locally, the IP-address is localhost and the port is1344

8083 by default.1345

Now, pressing “save” or “save as” in any form, will (copy and) commit your1346

model to the GIT repository, and then send the action you just performed1347

to the traceability daemon.1348

93

https://dl.dropboxusercontent.com/u/7249985/controllab/20sim/20-sim-4.6.3.7590-intocps-win32.exe
https://dl.dropboxusercontent.com/u/7249985/controllab/20sim/20-sim-4.6.3.7590-intocps-win32.exe
https://dl.dropboxusercontent.com/u/7249985/controllab/20sim/20-sim-4.6.3.7590-intocps-win32.exe
https://dl.dropboxusercontent.com/u/7249985/controllab/20sim/20-sim-4.6.3.7590-intocps-win32.exe
https://dl.dropboxusercontent.com/u/7249985/controllab/20sim/20-sim-4.6.3.7590-intocps-win32.exe


D4.3a - INTO-CPS Tool Chain User Manual (Public)

9 Code Generation for INTO-CPS1349

Of all the INTO-CPS tools, Overture, OpenModelica and 20-sim have the1350

ability, to varying degrees, to translate models into platform-independent C1351

source code. Overture can moreover translate VDM models written in the1352

executable subset of VDM++ [LLB11] (itself a subset of VDM-RT) to Java,1353

but C is the language of interest for the INTO-CPS technology.1354

The purpose of translating models into source code is twofold. First, the1355

source code can be compiled and wrapped as standalone FMUs for co-1356

simulation, such that the source tool is not required. Second, with the aid of1357

existing C compilers, the automatically generated source code can be com-1358

piled for specific hardware targets.1359

The INTO-CPS approach is to use 20-sim 4C to compile and deploy the code1360

to hardware targets, since the tool incorporates the requisite knowledge re-1361

garding compilers, target configuration etc. This is usually done for control1362

software modelled in one of the high-level modelling notations, after valida-1363

tion through the INTO-CPS tool chain. Deployment to target hardware is1364

also used for SiL and HiL validation and prototyping.1365

For each of the modelling and simulation tools of the INTO-CPS tool chain,1366

code generation is a standalone activity. As such, the reader should refer to1367

the tool-specific documentation referenced in Appendix B for guidance on1368

code generation. Deliverable D5.1d [HLG+15] contains the details of how1369

each tool approaches code generation.1370

The remainder of this section lists information about the code generation1371

capabilities of each tool. It describes what the user can expect currently1372

from each tool’s code generator, in the hopes that this will be helpful in1373

eliminating stumbling blocks for new users trying to quickly get started with1374

the INTO-CPS tool chain. Extensive guidance on how to tailor models for1375

problem-free translation to code can be found in the tools’ individual user1376

manuals, as referenced in Appendix B.1377

9.1 Overture1378

A complete description of Overture’s C code generator can be found in the1379

Overture User Manual, accessible through Overture’s Help system. As a1380

quick-start guide, this section only provides an introduction to invoking the1381

C code generator, and an overview of the features of VDM-RT that are1382
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currently considered stable from a code generation point of view. Please note1383

that exporting a source code FMU with Overture (Section 5.1) automatically1384

invokes the code generator and packages the result as an FMU.1385

The C code generator is invoked from the context menu in the Project Ex-1386

plorer as shown in Figure 95. The code generator currently supports the

Figure 95: Invoking the code generator.
1387

following VDM-RT language constructs:1388

• Basic data types and operations: integers, reals, booleans, etc.1389

• The is_ type test for basic types.1390

• Quote types.1391

• let expressions.1392

• Pattern matching.1393

• For and while loops.1394

• case expressions.1395

• Record types.1396

• Products.1397

• Aggregate types and operations: sets, sequences, maps (to a limited1398

extent).1399

• Object-oriented features: classes and class field access, inheritance,1400

method overloading and overriding, the self keyword, subclass re-1401

sponsibility, is not yet specified, multiple constructors, and1402

constructor calls within constructors.1403

• The time expression.1404

The following language features are not yet supported:1405

• Lambda expressions.1406
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• Pre-conditions, post-conditions and invariants.1407

• Quantifiers.1408

• Type queries on class instances.1409

• File I/O via the I/O library.1410

Most importantly, the development of Overture’s C code generator is now be-1411

ing geared toward resource-constrained embedded platforms. Improvements1412

are currently being made to enable deployment of the generated code on PIC1413

and ATmega microcontrollers.1414

A key feature of this development is the use of a garbage collector for memory1415

management. Generating a VDM-RT model to C code via the context menu1416

results in a main.c file containing a skeletal main() function. This function1417

contains calls to vdm_gc_init() and vdm_gc_shutdown(), the garbage1418

collector initialization and shutdown functions. The collector proper can not1419

be invoked automatically, so calls to the essential function vdm_gc() must1420

be inserted manually in the main code, for instance after each repetition of a1421

cyclic task. The source code FMU exporter, on the other hand, can handle1422

automatic invocation of the garbage collector, so no manual intervention is1423

required. Please note that it is generally unsafe to insert calls to vdm_gc()1424

in the generated code.1425

9.2 20-sim1426

20-sim supports ANSI-C and C++ code generation through the usage of1427

external and user-modifiable code-generation templates. Currently only a1428

subset of the supported 20-sim modelling language elements can be exported1429

as ANSI-C or C++ code code. The exact supported features depend on the1430

chosen template and its purpose and are discussed in Section 5.2.1431

The main purpose of the 20-sim code generator is to export control systems.1432

Therefore the focus in on running code on bare-bone targets (e.g. Arduino)1433

or as a real-time task on a real-time operating system.1434

The code generated by 20-sim does not contain any target-related or operat-1435

ing system specific code. The exported code is generated such that it can be1436

embedded in an external software project. For running 20-sim generated code1437

on a target, you can use 20-sim 4C. This is a tool that extends the 20-sim1438

generated code with target code based on target templates [Con16].1439
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9.3 OpenModelica1440

OpenModelica supports code generation from Modelica to source-code tar-1441

geting both ANSI-C and C++. From the generated source code, co-simulation1442

and model-exchange FMUs can be built. Currently, the only supported solver1443

in the generated co-simulation FMUs is forward Euler. Work to support ad-1444

ditional solvers is underway. The ability to deploy the generated code to1445

specific hardware targets will be supported via 20-sim 4C.1446

9.4 RT-Tester/RTT-MBT1447

When generating test FMUs from SysML discrete-event state-chart specifi-1448

cations using RTTester/RTT-MBT, the user should be aware of the following1449

sources of errors:1450

• Livelock resulting from a transition cycle in the state-chart specification1451

in which all transition guards are true simultaneously. This can be1452

checked separately using a livelock checker.1453

• Race conditions arising from parallel state-charts assigning different1454

values to the same variable. Model execution in this case will deadlock.1455

• State-charts specifying a replacement SUT must be deterministic.1456

10 Issue handling1457

Should you experience an issue while using one or more of the INTO-CPS1458

tools, please take the time to report the issue to the INTO-CPS project team,1459

so we can help you resolve it as soon as possible.1460

The following three small sub-sections will guide you through the three simple1461

steps of issue handling and reporting.1462

10.1 Are you using the newest INTO-CPS release?1463

Before you go any further with your current issue, please check that the1464

INTO-CPS version you are using is the newest. The version number is part1465

of the file name of the ZIP-bundle of the release. To find the list of released1466
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INTO-CPS bundle versions, and to see what the current version of INTO-1467

CPS is, please visit1468

https://github.com/into-cps/intocps-ui/releases/1469

10.2 Has the issue already been reported?1470

To make it easy for you to check whether the issue you are experiencing is1471

an already known one, we have created a list of all currently known issues1472

across all the INTO-CPS tools, with links directly to the online issue report1473

page of the relevant tool supplier. Have a quick look at the list, and if your1474

issue is already known, we recommend you follow the link and read more1475

about the specifics of the issue. Perhaps someone has found a work-around1476

or perhaps you have new information to add that might help the developers1477

solve the issue faster.1478

For the list of currently known issues, please visit1479

http://into-cps.github.io/weekly-issue/index.html1480

Note that some of the issue tracker sites might require you to register before1481

you can view or submit issues. Registration is free.1482

10.3 Reporting a new issue1483

If you have followed the steps in the two previous sections and are now1484

certain that you have spotted a new issue relating to a specific INTO-CPS1485

tool, please visit the issue tracker site for that tool and report it. To ease1486

this process we have listed direct links for each tool to their relevant online1487

issue reporting page. To see the list of issue tracker links please visit1488

http://into-cps.github.io/report-an-issue.html1489

11 Conclusions1490

This deliverable is the user manual for the INTO-CPS tool chain after the1491

second year of the project. The tool chain supports model-based design and1492

validation of CPSs, with an emphasis on multi-model co-simulation.1493
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Several independent simulation tools are orchestrated by a custom co-simu-1494

lation orchestration engine, which implements both fixed and variable step1495

size co-simulation semantics. A multi-model thus co-simulated can be fur-1496

ther verified through automated model-based testing and bounded model1497

checking.1498

The tool chain benefits from a cohesive management interface, the INTO-1499

CPS Application, the main gateway to modelling and validation with the1500

INTO-CPS technology. Following the manual should give a new user of the1501

INTO-CPS tool chain an understanding of all the elements of the INTO-CPS1502

vision for co-simulation. This manual is accompanied by tutorial material1503

and guidance on the main INTO-CPS tool chain website,1504

http://into-cps.github.io1505

Features that have not yet been fully developed or integrated with the INTO-1506

CPS Application are currently being addressed and are targeted for the final1507

year of the INTO-CPS project.1508
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COE Co-simulation Orchestration Engine
CORBA Common Object Request Broker Architecture
CPS Cyber-Physical Systems
CT Continuous-Time
DE Discrete Event
DESTECS Design Support and Tooling for Embedded Control Software
DSE Design Space Exploration
FMI Functional Mockup Interface
FMI-Co Functional Mockup Interface – for Co-simulation
FMI-ME Functional Mockup Interface – Model Exchange
FMU Functional Mockup Unit
HiL Hardware-in-the-Loop
HMI Human Machine Interface
HW Hardware
ICT Information Communication Technology
IDE Integrated Design Environment
LTL Linear Temporal Logic
M&S Modelling and Simulation
MARTE Modeling and Analysis of Real-Time and Embedded Systems
MBD Model-based Design
MBT Model-based Testing
MC/DC Modified Decision/Condition Coverage
MDE Model Driven Engineering
MiL Model-in-the-Loop
MIWG Model Interchange Working Group
OMG Object Management Group
OS Operating System
PID Proportional Integral Derivative
PROV-N The Provenance Notation
RPC Remote Procedure Call
RTT Real-Time Tester
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SMT Satisfiability Modulo Theories
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SUT System Under Test
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SysML Systems Modelling Language
TA Test Automation
TE Test Environment
TR TRansitions
TRL Technology Readiness Level
TWT TWT GmbH Science & Innovation
UML Unified Modelling Language
UNEW University of Newcastle upon Tyne
UTP Unifying Theories of Programming
UTRC United Technologies Research Center
UY University of York
VDM Vienna Development Method
VSI Verified Systems International
WP Work Package
XML Extensible Markup Language
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B Background on the Individual Tools1644

This appendix provides background information on each of the independent1645

tools of the INTO-CPS tool chain.1646

B.1 Modelio1647

Modelio is a comprehensive MDE [Fav05] workbench tool which supports1648

the UML2.x standard. Modelio adds modern Eclipse-based graphical envi-1649

ronment to the solid modelling and generation know-how obtained with the1650

earlier Softeam MDE workbench, Objecteering, which has been on the mar-1651

ket since 1991. Modelio provides a central repository for the local model,1652

which allows various languages (UML profiles) to be combined in the same1653

model, abstraction layers to be managed and traceability between different1654

model elements to be established. Modelio makes use of extension modules,1655

enabling the customization of this MDE environment for different purposes1656

and stakeholders. The XMI module allows models to be exchanged between1657

different UML modelling tools. Modelio supports the most popular XMI1658

UML2 flavors, namely EMF UML2 and OMG UML 2.3. Modelio is one of1659

the leaders in the OMG Model Interchange Working Group (MIWG), due to1660

continuous work on XMI exchange improvements.1661

Among the extension modules, some are dedicated to IT system architects.1662

For system engineering, SysML or MARTE modules can be used. They1663

provide dedicated modelling support for dealing with general, software and1664

hardware aspects of embedded or cyber physical systems. In addition, sev-1665

eral utility modules are available, such as the Document Publisher which1666

provides comprehensive support for the generation of different types of doc-1667

ument.1668

Modelio is highly extendable and can be used as a platform for building1669

new MDE features. The tool enables users to build UML2 Profiles, and to1670

combine them with a rich graphical interface for dedicated diagrams, model1671

element property editors and action command controls. Users can use several1672

extension mechanisms: light Python scripts or a rich Java API, both of which1673

provide access to Modelio‘s model repository and graphical interface.1674
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B.2 Overture1675

The Overture platform [LBF+10] is an Eclipse-based integrated development1676

environment (IDE) for the development and validation of system specifica-1677

tions in three dialects of the specification language of the Vienna Develop-1678

ment Method. Overture is distributed with a suite of examples and step-by-1679

step tutorials which demonstrate the features of the three dialects. A user1680

manual for the platform itself is also provided [LLJ+13], which is accessible1681

through Overture’s help system. Although certain features of Overture are1682

relevant only to the development of software systems, VDM itself can be used1683

for the specification and validation of any system with distinct states, known1684

as discrete-event systems, such as physical plants, protocols, controllers (both1685

mechanical and software) etc., and Overture can be used to aid in validation1686

activities in each case.1687

Overture supports the following activities:1688

• The definition and elaboration of syntactically correct specifications in1689

any of the three dialects, via automatic syntax and type validation.1690

• The inspection and assay of automatically generated proof obligations1691

which ensure correctness in those aspects of specification validation1692

which can not be automated.1693

• Direct interaction with a specification via an execution engine which1694

can be used on those elements of the specification written in an exe-1695

cutable subset of the language.1696

• Automated testing of specifications via a custom test suite definition1697

language and execution engine.1698

• Visualization of test coverage information gathered from automated1699

testing.1700

• Visualization of timing behaviours for specifications incorporating tim-1701

ing information.1702

• Translation to/from UML system representations.1703

• For specifications written in the special executable subset of the lan-1704

guage, obtaining Java implementations of the specified system auto-1705

matically.1706

For more information and tutorials, please refer to the documentation dis-1707

tributed with Overture.1708
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The following is a brief introduction to the features of the three dialects of1709

the VDM specification language.1710

VDM-SL This is the foundation of the other two dialects. It supports the1711

development of monolithic state-based specifications with state transition1712

operations. Central to a VDM-SL specification is a definition of the state1713

of the system under development. The meaning of the system and how it1714

operates is conveyed by means of changes to the state. The nature of the1715

changes is captured by state-modifying operations. These may make use of1716

auxiliary functions which do not modify state. The language has the usual1717

provisions for arithmetic, new dependent types, invariants, pre- and post-1718

conditions etc. Examples can be found in the VDM-SL tutorials distributed1719

with Overture.1720

VDM++ The VDM++ dialect supports a specification style inspired by1721

object-oriented programming. In this specification paradigm, a system is1722

understood as being composed of entities which encapsulate both state and1723

behaviour, and which interact with each other. Entities are defined via tem-1724

plates known as classes. A complete system is defined by specifying instances1725

of the various classes. The instances are independent of each other, and they1726

may or may not interact with other instances. As in object-oriented program-1727

ming, the ability of one component to act directly on any other is specified1728

in the corresponding class as a state element. Interaction is naturally carried1729

out via precisely defined interfaces. Usually a single class is defined which1730

represents the entire system, and it has one instance, but this is only a con-1731

vention. This class may have additional state elements of its own. Whereas a1732

system in VDM-SL has a central state which is modified throughout the life-1733

time of the system, the state of a VDM++ system is distributed among all of1734

its components. Examples can be found in the VDM++ tutorials distributed1735

with Overture.1736

VDM-RT VDM-RT is a small extension to VDM++ which adds two pri-1737

mary features:1738

• The ability to define how the specified system is envisioned to be allo-1739

cated on a distributed execution platform, together with the commu-1740

nication topology.1741

• The ability to specify the timing behaviours of individual components,1742

as well as whether certain behaviours are meant to be cyclical.1743

108



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Finer details can be specified, such as execution synchronization and mu-1744

tual exclusion on shared resources. A VDM-RT specification has the same1745

structure as a VDM++ specification, only the conventional system class of1746

VDM++ is mandatory in VDM-RT. Examples can be found in the VDM-RT1747

tutorials distributed with Overture.1748

B.3 20-sim1749

20-sim [Con13, Bro97] is a commercial modelling and simulation software1750

package for mechatronic systems. With 20-sim, models can be created graph-1751

ically, similar to drawing an engineering scheme. With these models, the1752

behaviour of dynamic systems can be analyzed and control systems can be1753

designed. 20-sim models can be exported as C-code to be run on hardware1754

for rapid prototyping and HiL-simulation. 20-sim includes tools that allow1755

an engineer to create models quickly and intuitively. Models can be cre-1756

ated using equations, block diagrams, physical components and bond graphs1757

[KR68]. Various tools give support during the model building and simulation.1758

Other toolboxes help to analyze models, build control systems and improve1759

system performance. Figure 96 shows 20-sim with a model of a controlled

Figure 96: Example of a hexapod model in 20-sim.
1760

hexapod. The mechanism is generated with the 3D Mechanics Toolbox and1761

connected with standard actuator and sensor models from the mechanics li-1762

brary. The hexapod is controlled by PID controllers which are tuned in the1763
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frequency domain. Everything that is required to build and simulate this1764

model and generate the controller code for the real system is included inside1765

the package.1766

The 20-sim Getting Started manual [KG16] contains examples and step-by-1767

step tutorials that demonstrate the features of 20-sim. More information on1768

20-sim can be found at http://www.20sim.com and in the user manual1769

at http://www.20sim.com/webhelp [KGD16]. The integration of 20-1770

sim into the INTO-CPS tool-chain is realized via the FMI standard.1771

B.4 OpenModelica1772

OpenModelica [Fri04] is an open-source Modelica-based modelling and sim-1773

ulation environment. Modelica [FE98] is an object-oriented, equation based1774

language to conveniently model complex physical systems containing, e.g.,1775

mechanical, electrical, electronic, hydraulic, thermal, control, electric power1776

or process-oriented subcomponents. The Modelica language (and OpenMod-1777

elica) supports continuous, discrete and hybrid time simulations. OpenMod-1778

elica already compiles Modelica models into FMU, C or C++ code for simula-1779

tion. Several integration solvers, both fixed and variable step size, are avail-1780

able in OpenModelica: euler, rungekutta, dassl (default), radau5, radau3,1781

radau1.1782

OpenModelica can be interfaced to other tools in several ways as described1783

in the OpenModelica user’s manual [Ope]:1784

• via command line invocation of the omc compiler1785

• via C API calls to the omc compiler dynamic library1786

• via the CORBA interface1787

• via OMPython interface [GFR+12]1788

OpenModelica has its own scripting language, Modelica script (mos files),1789

which can be used to perform actions via the compiler API, such as load-1790

ing, compilation, simulation of models or plotting of results. OpenModelica1791

supports Windows, Linux and Mac Os X.1792

The integration of OpenModelica into the INTO-CPS tool chain is realized1793

via compliance with the FMI standard, and is described in deliverable D4.1b1794

[PBLG15].1795
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B.5 RT-Tester1796

The RT-Tester [Ver15a] is a test automation tool for automatic test gener-1797

ation, test execution and real-time test evaluation. Key features include a1798

strong C/C++-based test script language, high performance multi-threading,1799

and hard real-time capability. The tool has been successfully applied in avion-1800

ics, rail automation, and automotive test projects. In the INTO-CPS tool1801

chain, RT-Tester is responsible for model-based testing, as well as for model1802

checking. This section gives some background information on the tool from1803

these two perspectives.1804

B.5.1 Model-based Testing1805

The RT-Tester Model Based Test Case and Test Data Generator (RTT-1806

MBT) [Ver15b] supports model-based testing (MBT), that is, automated1807

generation of test cases, test data, and test procedures from UML/SysML1808

models. A number of common modelling tools can be used as front-ends for1809

this. The most important technical challenge in model-based test automation1810

is the extraction of test cases from test models. RTT-MBT combines an SMT1811

solver with a technique akin to bounded model checking so as to extract finite1812

paths through the test model according to some predefined criterion. This1813

criterion can, for instance, be MC/DC coverage, or it can be requirements1814

coverage (if the requirements are specified as temporal logic formulae within1815

the model). A further aspect is that the environment can be modelled within1816

the test model. For example, the test model may contain a constraint such1817

that a certain input to the system-under-test remains in a predefined range.1818

This aspect becomes important once test automation is lifted from single test1819

models to multi-model cyber-physical systems. The derived test procedures1820

use the RT-Tester Core as a back-end, allowing the system under test to be1821

provided on real hardware, software only, or even just simulation to aid test1822

model development.1823

Further, RTT-MBT includes requirement tracing from test models down to1824

test executions and allows for powerful status reporting in large scale testing1825

projects.1826

B.5.2 Model Checking of Timed State Charts1827

RTT-MBT applies model checking to behavioural models that are specified1828

as timed state charts in UML and SysML, respectively. From these models,1829
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a transition relation is extracted and represented as an SMT formula in bit-1830

vector theory [KS08], which is then checked against LTL formulae [Pnu77]1831

using the algorithm of Biere et al. [BHJ+06]. The standard setting of RTT-1832

MBT is to apply model checking to a single test model, which consists of the1833

system specification and an environment.1834

• A component called TestModel that is annotated with stereotype TE.1835

• A component called SystemUnderTest that is annotated with stereo-1836

type SUT.1837

RTT-MBT uses the stereotypes to infer the role of each component. The in-1838

teraction between these two parts is implemented via input and output inter-1839

faces that specify the accessibility of variables using UML stereotypes.1840

• A variable that is annotated with stereotype SUT2TE is written by1841

the system model and readable by the environment.1842

• A variable that is annotated with stereotype TE2SUT is written by1843

the environment and read by the system model as an input.1844

A simple example is depicted in Figure 97, which shows a simple composite1845

structure diagram in Modelio for a turn indication system. The purpose1846

of the system is to control the lamps of a turn indication system in a car.1847

Further details are given in [Ver13]. The test model consists of the two1848

aforementioned components and two interfaces:1849

• Interface1 is annotated with stereotype TE2SUT and contains three1850

variables voltage, TurnIndLvr and EmerSwitch. These variables1851

are controlled by the environment and fed to the system under test as1852

inputs.1853

• Interface2 is annotated with stereotype SUT2TE and contains two1854

variables LampsLeft and LampsRight. These variables are con-1855

trolled by the system under test and can be read by the environment.1856

Observe that the two variables LampsLeft and LampsRight have type
int, but should only hold values 0 or 1 to indicate states on or off. A
straightforward system property that could be verified would thus be that
LampsLeft and LampsRight indeed are only assigned 0 or 1, which could
be expressed by the following LTL specification:

G(0 ≤ LampsLeft ≤ 1 ∧ 0 ≤ LampsRight ≤ 1)

A thorough introduction with more details is given in the RTT-MBT user1857

manual [Ver13].1858
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Figure 97: Simple model that highlights interfaces between the environment
and the system-under-test.
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C Underlying Principles1859

The INTO-CPS tool chain facilitates the design and validation of CPSs1860

through its implementation of results from a number of underlying principles.1861

These principles are co-simulation, design space exploration, model-based1862

test automation and code generation. This appendix provides an introduc-1863

tion to these concepts.1864

C.1 Co-simulation1865

Co-simulation refers to the simultaneous simulation of individual models1866

which together make up a larger system of interest, for the purpose of ob-1867

taining a simulation of the larger system. A co-simulation is performed by a1868

co-simulation orchestration engine. This engine is responsible for initializing1869

the individual simulations as needed; for selecting correct time step sizes such1870

that each constituent model can be simulated successfully for that duration,1871

thus preventing time drift between the constituent simulations; for asking1872

each individual simulation to perform a simulation step; and for synchro-1873

nizing information between models as needed after each step. The result of1874

one such round of simulations is a single simulation step for the complete1875

multi-model of the system of interest.1876

As an example, consider a very abstract model of a nuclear power plant. This1877

consists of a nuclear reactor core, a controller for the reactor, a water and1878

steam distribution system, a steam-driven turbine and a standard electrical1879

generator. All these individual components can be modelled separately and1880

simulated, but when composed into a model of a nuclear power plant, the1881

outputs of some become the inputs of others. In a co-simulation, outputs1882

are matched to inputs and each component is simulated one step at a time1883

in such a way that when each model has performed its simulation step, the1884

overall result is a simulation step of the complete power plant model. Once1885

the correct information is exchanged between the constituent models, the1886

process repeats.1887

C.2 Design Space Exploration1888

During the process of developing a CPS, either starting from a completely1889

blank canvas or constructing a new system from models of existing compo-1890

nents, the architects will encounter many design decisions that shape the1891
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final product. The activity of investigating and gathering data about the1892

merits of the different choices available is termed Design Space Exploration.1893

Some of the choices the designer will face could be described as being the1894

selection of parameters for specific components of the design, such as the1895

exact position of a sensor, the diameter of wheels or the parameters affecting1896

a control algorithm. Such parameters are variable to some degree and the1897

selection of their value will affect the values of objectives by which a design1898

will be measured. In these cases it is desirable to explore the different values1899

each parameter may take and also different combinations of these parameter1900

values if there are more than one parameter, to find a set of designs that best1901

meets its objectives. However, since the size of the design space is the prod-1902

uct of the number of parameters and the number of values each may adopt,1903

it is often impractical to consider performing simulations of all parameter1904

combinations or to manually assess each design.1905

The purpose of an automated DSE tool is to help manage the exploration1906

of the design space, and it separates this problem into three distinct parts:1907

the search algorithm, obtaining objective values and ranking the designs1908

according to those objectives. The simplest of all search algorithms is the1909

exhaustive search, and this algorithm will methodically move through each1910

design, performing a simulation using each and every one. This is termed1911

an open loop method, as the simulation results are not considered by the1912

algorithm at all. Other algorithms, such as a genetic search, where an initial1913

set of randomly generated individuals are bred to produce increasingly good1914

results, are closed loop methods. This means that the choice of next design1915

to be simulated is driven by the results of previous simulations.1916

Once a simulation has been performed, there are two steps required to close1917

the loop. The first is to analyze the raw results output by the simulation to1918

determine the value for each of the objectives by which the simulations are1919

to be judged. Such objective values could simply be the maximum power1920

consumed by a component or the total distance traveled by an object, but1921

they could also be more complex measures, such as the proportion of time1922

a device was operating in the correct mode given some conditions. As well1923

as numerical objectives, there can also be constraints on the system that1924

are either passed or failed. Such constraints could be numeric, such as the1925

maximum power that a substation must never exceed, or they could be based1926

on temporal logic to check that undesirable events do not occur, such as all1927

the lights at a road junction not being green at the same time.1928

The final step in a closed loop is to rank the designs according to how well1929

each performs. The ranking may be trivial, such as in a search for a design1930
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that minimizes the total amount of energy used, or it may be more complex1931

if there are multiple objectives to optimize and trade off. Such ranking1932

functions can take the form of an equation that returns a score for each1933

design, where the designs with the highest/lowest scores are considered the1934

best. Alternatively, if the relationship between the desired objectives is not1935

well understood, then a Pareto approach can be taken to ranking, where1936

designs are allocated to ranks of designs that are indistinguishable from each1937

other, in that each represents an optimum, but there exist different tradeoffs1938

between the objective values.1939

C.3 Model-Based Test Automation1940

The core fragment of test automation activities is a model of the desired1941

system behaviour, which can be expressed in SysML. This test model in-1942

duces a transition relation, which describes a collection of execution paths1943

through the system, where a path is considered a sequence of timed data1944

vectors (containing internal data, inputs and outputs). The purpose of a test1945

automation tool is to extract a subset of these paths from the test model1946

and turn these paths into test cases, respectively test procedures. The test1947

procedures then compare the behaviour of the actual system-under-test to1948

the path, and produce warnings once discrepancies are observed.1949

C.4 Code Generation1950

Code generation refers to the translation of a modelling language to a com-1951

mon programming language. Code generation is commonly employed in con-1952

trol engineering, where a controller is modelled and validated using a tool1953

such as 20-sim, and finally translated into source code to be compiled for1954

some embedded execution platform, which is its final destination.1955

The relationship that must be maintained between the source model and1956

translated program must be one of refinement, in the sense that the trans-1957

lated program must not do anything that is not captured by the original1958

model. This must be considered when translating models written in high-1959

level specification languages, such as VDM. The purpose of such languages1960

is to allow the specification of several equivalent implementations. When1961

a model written in such a language is translated to code, one such imple-1962

mentation is essentially chosen. In the process, any non-determinism in the1963

specification, the specification technique that allows a choice of implemen-1964
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tations, must be resolved. Usually this choice is made very simple by re-1965

stricting the modelling language to an executable subset, such that no such1966

non-determinism is allowed in the model. This restricts the choice of imple-1967

mentations to very few, often one, which is the one into which the model is1968

translated via code generation.1969
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